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1 Introduction to MADSEN Itera II
MADSEN Itera II is an audiometer for testing a person's hearing.

With MADSEN Itera II you can perform all standard audiometric tests, tone and speech
audiometry and special tests.

Depending on the configuration, various special tests such as SISI, Stenger, ABLB (Fowler),
and HIS are available.

• MADSEN Itera II can be used in connection with the OTOsuite Audiometry Module software for online monitoring
of test results, data export and storage, printing, and NOAH compatibility.

• MADSEN Itera II can be used as a portable instrument or as a desktop unit (fixed installation).

Operation
The front panel buttons have indicator lights, which clearly show the device's current settings.

Sound level, frequency and other information are shown clearly on the device display.

Speech input signals can be taken from a CD player, tape recorder and internal or external microphones. The masking sig-
nal for speech audiometry can be presented together with the speech signal for the ear being examined - "Speech in
Noise".

Output options
There are three output options:

• standard headphones (AC),

• bone conductors (BC)

• special output (SF), which can be connected for instance to a free-field loudspeaker or insert phone (see available out-
put in SETUP items► 87).

MADSEN Itera II can be calibrated for several types of headphones simultaneously.

Transferring data to and from a pc
The test results are stored in the device - even when it is switched off. The results can be transferred to a PC and displayed
in OTOsuite (see Managing Data and Results► 83).

You can download new firmware to MADSEN Itera II, and if this involves no change to the transducers, MADSEN Itera II
does not need to be recalibrated.

1.1 The Audiometry Module

OTOsuite
OTOsuite is a software tool that integrates a suite of audiological tests with result review
and reporting capabilities into a single powerful PC application.

The OTOsuite Audiometry Module is designed to operate with MADSEN Itera II as the test device.

The OTOsuite AudiometryModule
The OTOsuite Audiometry Module provides you with comprehensive control and overview of the current stimulus and
masking choices both numerically and graphically in the displayed audiogram when you test with a connected Otometrics
audiometer.
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As the module is part of OTOsuite, audiograms can be used directly in other OTOsuite modules such as the PMM and
Immittance modules for an optimized workflow independent of NOAH, and for combined reporting.

The OTOsuite Audiometry Module supports
• basic tone audiometry and

• speech testing

• a range of special tests.

Masking AssistantTM
The special Masking AssistantTM feature will notify you of thresholds that you might consider checking again with masking
applied. You may use this feature not only during testing but also to pinpoint possible masking issues with previously recor-
ded audiograms. The applied masking rules match the general recommendations in the audiometry literature.

Over the rim testing
Testing with the audiometer connected to a PC allows you to use the audiometer primarily as a handy control panel while
you follow the actual stimulus settings and test progress on your standard PC display. The large stimulus and patient
response graphics at the top of the display gives you a clear overview while keeping your focus on the patient.

1.2 Intended use

MADSEN Itera II and the Audiometrymodule
Users: audiologists, ENTs and other health care professionals in testing the hearing of their patients.

Use: diagnostic and clinical audiometric testing.

1.3 About this manual
This is your guide to installing, calibrating and using MADSEN Itera II and to using the OTOsuite Audiometry Module. It also
introduces you to the key features of the device and the software, as well as to working scenarios for performing tests and
viewing and printing test results.

We strongly recommend that you read this manual carefully before using MADSEN Itera II and the Audiometry Module for
the first time.

Note • If you are using the Audiometry Module with NOAH, we recommend that you are familiar with the screens
and functions provided in NOAH.

Training
It is recommended that you read this manual and the OTOsuite Platform User Manual, and make yourself familiar with
MADSEN Itera II before you begin testing a patient.

Terminology
The correct term for the person being tested/evaluated/serviced may depend on the setting in which the system is being
used. For this manual the term “Patient” was chosen, but when you use MADSEN Itera II with OTOsuite, you can configure
OTOsuite to use another term.

8 Otometrics - MADSEN Itera II
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1.3.1 Safety
This User Manual contains information and warnings which must be followed to ensure the safe performance of MADSEN
Itera II and the OTOsuite Audiometry Module.

Warning•Local government rules and regulations, if applicable, should be followed at all times.

Safety information is stated where it is relevant, and general safety aspects are described in Standards and safety► 113.

• Standards and safety► 113 gives you an overview of device labelling and standards.

• Warning notes► 114 contains relevant warning notes.

1.4 Typographical conventions

The use ofWarning, Caution and Note
To draw your attention to information regarding safe and appropriate use of the device or software, the manual uses pre-
cautionary statements as follows:

Warning• Indicates that there is a risk of death or serious injury to the user or patient.

Caution• Indicates that there is a risk of injury to the user or patient or risk of damage to data or the device.

Note • Indicates that you should take special notice.

1.4.1 Navigation in this manual
Menus, icons and functions to select are shown in bold type, as for instance in:

• Click the Set Options icon on the toolbar or select Tools > Options...

Otometrics - MADSEN Itera II 9
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2 Getting started with MADSEN Itera II and the
OTOsuite Audiometry Module

2.1 Unpacking
1. Inspect the package and its contents for possible visual damage.

2. Check with the packing list to make sure that you have received all necessary parts and accessories. If your package is
incomplete, contact your supplier.

2.2 Getting started

Training
We recommend that you read this manual and make yourself familiar with the MADSEN Itera II, and how it operates with
the OTOsuite Audiometry Module.

Safety
For safety information, see
• Standards and safety► 113

Installation
• To install the new system, see Unpacking and installing► 103

• If you are using OTOsuite, install OTOsuite from the OTOsuite Installation disk. See the OTOsuiteInstallation Manual.

Connecting toMADSEN Itera II
Socket connections - rear panel► 26 shows the location of the sockets for the various accessories required.

• To connect the accessories, see Installation► 103:

– Connect the Patient Response Switch.

– Connect headphones/insert phones.

– If bone conduction is required, connect the bone conductor.

– Connect external and Free Field microphones if required.

Configuring the OTOsuite AudiometryModule
• See see Configuring the Audiometry Module► 99.

Preparing for testing
Before you receive the client and start the session of testing and explaining test results, your time is well spent preparing
for the session.

• Test preparations are described in Preparing for testing► 51

• Customization of the test equipment is described in Customizing your setup► 12

Descriptions and testing
In order for you to feel well prepared and confident before you receive clients for testing using the Audiometry Module,
see the test screen descriptions. They provide you with examples on how to view the test results.

• The basic OTOsuite functions are described in the OTOsuiteUser Guide.

• The test screens are described in Navigating in the OTOsuiteAudiometry Module► 29.
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Printing
• See the OTOsuiteUser Guide.

2.3 Customizing your setup
With Itera II you can quickly and easily customize your test sequences for maximum efficiency.

Changing the setup
Make the changes you want in the setup of Itera II and save these changes in the specific test setup.

Example
1. Set dB STEP to 1 dB (press button 1 in the dB STEP column).

2. Press SETUP twice to enter setup mode.

3. Turn the Left dB LEVEL knob until SAVE TEST SETUP is shown on the display.

4. Press STORE.

5. Turn Itera II off and then on again. It now remembers your preferred settings.

Shortcuts
A number of functions in Itera II can be activated by a shortcut so that you just have to press and hold the appropriate but-
ton and turn the knob.

For a full list of shortcuts, see Temporary changes in the setup► 86.

Example
1. Press the SPEECH button to select Speech mode.

2. PressMIC to select microphone.

3. Press and holdMICwhile you turn the Right level knob. You will then adjust the sensitivity of this microphone.

12 Otometrics - MADSEN Itera II
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3 Overview of MADSEN Itera II
A. Rear panel connections
The rear panel contains the sockets for connecting various accessories
and the socket for power connection. See Socket connections - rear
panel► 26.

B. On/Off switch
The side panel contains the On/Off switch. See Side panel► 28.

C. Display
Settings and the test as it progresses are shown on the display. See Dis-
play► 13.

D. Front panel controls
MADSEN Itera II is operated from the front panel. See Front panel con-
trols► 15.

3.1 Display
A. Test signal indicator
B. Audiogram symbols
C. Stored threshold
D. Ear indicator
E. Function key markers

During start-up the display briefly shows information regarding the device type and version, followed by the test screen last
used.

The abbreviations used on the display are explained in Abbreviations► 111.

Top line
• During Tone testing the upper line in the display shows the intensity numerically in dB HL for the left and right ear.

• During Speech testing and HIS the upper line is transformed into one or two VU meters.

Ear selection
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The ear being tested is indicated with L or R in the display. The display side for L and R can be changed in the settings. See
SETUP items► 87.

Frequency

The selected test frequency for tone testing is shown at the center.

Masking
If masking for the contralateral ear is enabled, this is shown on the opposite side.

Symbols used

Left ear
Response/No response

Right ear
Response/No response

Air, unmasked

Air, masked

Bone, mastoid, unmasked

Bone, mastoid, masked

Sound field, unmasked (binaural - applies to both
ears)

Sound field, masked

UCL (UnComfortable Loudness level)

MCL (Most Comfortable Loudness level)
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Other symbols

Stored results on this frequency

3.2 Front panel controls
You can access all basic functions directly by using the buttons and knobs on the front panel.

The button light indicators
Each button has its own function. Some buttons have a light to indicate whether the function is currently active or not.

• Press the button to activate.

• Press the button again to deactivate.

3.2.1 Front panel layout
The MADSEN Itera II buttons and controls are grouped according to their function and how frequently they are used.

The buttons and knobs most frequently used are placed directly below the display.

Otometrics - MADSEN Itera II 15
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A. Test column► 16
B. Transducer column► 17
C. Signal column► 18
D. Input - MIC, CD, REVERSE►

18
E. Signal indicators► 19
F. Extended range► 19

Change Ear (L <--> R)► 20
G. Setup► 20

Talk back► 20

H. Masking► 20
I. dB steps► 21
J. Display► 13
K. Microphone► 21
L. Talk over► 22
M. Response indicator► 22
N. Start/Pause/Stop► 22
O. Store/toggle threshold status

► 23

P. Stimulus/masking intensity knobs
► 23

Q. Stimulus/speech count buttons►
24

R. Frequency► 25
S. Erase► 25
T. Xmit► 26

Beep
If you try to use a button which is not enabled, you will hear two short beeps.

MADSEN Itera II also beeps when the SISI test is completed.

3.2.2 Test column
Press to select the test:

16 Otometrics - MADSEN Itera II
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• TONE

Selects the Tone Threshold test.

• SPEECH

Selects the Speech test.

• SPECIAL
Press to see the optional test types. Press the desired function key to select.

On versions of Itera II supplied with more than three special tests, press SPECIAL again while its LED is
flashing. This will display the names of more Special tests.

The most recently used special test always appears in the first row the next time you select SPECIAL.

For a description of the special tests, see

– MCL tone testing► 73

– UCL tone testing► 73

– SISI (Short Increment Sensitivity Index)► 73

– ABLB (Alternate Binaural Loudness Balance)► 75

– STENGER Test► 76

– Hearing Instrument Simulation (HIS)► 77

Current test settings
When you switch to a new test, the current setting of the test that you are leaving will be saved and re-established when
you return to the test.

3.2.3 Transducer column
Press to select the output transducer:

• AC

Selects the Air Conductor

• BC

Selects the Bone Conductor

• SF

Selects the Special Transducer

The identity of the transducer selected under SETUP is displayed as long as you press the button.

If a headphone/transducer is not selected under SETUP, SETUP items► 87, SETUP items► 87 and
SETUP items► 87, the relevant transducer cannot be selected.
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3.2.4 Signal column

WARBLE
Presentation of warble tone stimulus (WRB).

Warble shortcut functions

Warble frequency To change the warble frequency, press and holdWARBLE, while you turn the
left LEVEL selector.

Warble modulation To change warble modulation width, press and holdWARBLE, while you turn
the Right level selector.

PULSE
The test signal is presented with a Pulse/Pause ratio of 50%.

Pulse shortcut functions

Pulse frequency To change the pulse frequency, turn the Right level selector while you
press and hold PULSE.

IMPULSE
The test signal is presented within a preset period of time.

Impulse shortcut functions

Test signal duration To change the duration of the test signal, turn the Right level selector
while you press and hold IMPULSE.

3.2.5 Input - MIC, CD, REVERSE

MIC.
PressMIC. to select the signal from external or internal microphone input. The internal microphone is loc-
ated below the display. External microphones are for instance the goose neck microphone, or, if you are
using a monitor headset, the boom microphone.

CD.
Press CD to select the signal from external CD/TAPE input.

MIC/CD shortcut functions

Input signal sens-
itivity, MIC/CD

You can adjust the input signal sensitivity by holding down the MIC or CD button
and turning the LEVEL selector that is closest to the test signal side.

18 Otometrics - MADSEN Itera II
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REVERSE
Press REVERSE to toggle the function of the Interrupter between:

• REVERSE (lamp lit)
If REVERSE is on (the test signal is activated continuously), the test signal is interrupted when you press INT.

• Normal
The test signal is applied when you press INT.

Note •The presentation only applies to the test signal. The masking signal is normally always ON. You can
change the masking interrupter's function under SETUP, SETUP items► 87.

The permitted signal source depends on the TEST selected, see Display► 13.

Speech and HIS
• Press REVERSE to toggle the signal.

3.2.6 Signal indicators
Output

The indicators are located on either side of the display. They light up when the selected test signal is presen-
ted in the corresponding ear.

3.2.7 Extended range
Enables presentation of stimuli above the safety limit (approx. 100 dB). The safety limit is set to 20 dB below
the maximum dB HL for a given transducer and frequency.

The exception is at 125 Hz, where the limit is 30 dB below the maximum dB HL.

Extended Range has three modes (to select, see SETUP, SETUP items► 87):

• Auto
All levels at all frequencies are always accessible, but the Extended Range button is lit when a level above the safety
limit is reached.

• Manual
You must manually press the Extended Range button to test above the safety limit.

• Timeout
Selection of the time interval that passes between the device standing untouched and the EXTended (sound intensity)
RANGE is deactivated.

EXT. RANGE is automatically disabled when:

• the intensity falls below the limit selected under SETUP, SETUP items► 87,

• the duration set for Ext. Range Timeout is exceeded and the device has been inactive (SETUP, SETUP items► 87),

• you select a new test, or

Otometrics - MADSEN Itera II 19
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• you change FREQUENCY, see Frequency► 25.

3.2.8 Change Ear (L <--> R)
• Press this button to switch between testing the left and right ear.

Speech test
• Press twice (L+R) during the speech test to send the test signal to both ears, giving "Binaural Speech".

• Use L <--> R to mix the signals in speech testing.

• Use L <--> R to control setup masking in one ear in binaural speech testing.

3.2.9 Setup
Changing the setup temporarily
To change the setup temporarily, use the Shortcut function (Temporary changes in the setup► 86). These changes will
not be saved when you switch off the device.

Changing the setup permanently
To change the setup permanently, press the SETUP button to access the various parameters. See Permanent changes in
the setup► 85.

1. Press SETUP twice to change default settings, see Setup of parameters► 85. This serves to prevent
accidental changes in the setup.

– SISI
Press SETUP to enable the number of small increments to be changed using the right LEVEL
selector.

– Fowler (ABLB)
Press SETUP to enable changing the frequency of the alternating tone using the right LEVEL
selector.

3.2.10 Talk back
The patient's speech is always fed back to the operator's monitor headphone.

You can remove the signal

• by lowering the Talk Back volume (SETUP, SETUP items► 87), or

• by setting the switch on the Talk Back microphone to OFF.

You can choose to have the test signal and/or the masking signal switched ON or OFF in the monitor headphone (SETUP,
SETUP items► 87).

Talk back shortcut functions

Setup - volume To adjust the volume, press and hold TALK BACK while turning the right LEVEL selector.

3.2.11 Masking
• By default, you always adjust the stimulus signal level on the Left Level knob, regardless of whether you are testing

the right or left ear.
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• To adjust the masking intensity use the Right Level knob.

To change the default setting, select SETUP, SETUP items► 87.

OFF
No masking

ON
To adjust the masking intensity independently of the signal level use the Right level knob.

LOCK

Makes the masking level follow the stimulus signal level. You can adjust the difference between the stimulus
signal and the masking signal by using the Right level knob.

MASK shortcut functions

Masking transducer selection When masking is already selected and you press the same masking button once
more, the masking transducer, the masking signal type and the name of the trans-
ducer, and (if applicable) the serial no. appear in the display.

The transducer button flashes and you can then select a different masking trans-
ducer by pressing one of the three TRANSD buttons AC, BC or SF.

Masking noise in Speech Select the masking ear: press and holdMASK ON and press L <--> R to toggle
between left, right and both ears.

3.2.12 dB steps
Choose between the following attenuator steps:

1 dB
2.5 dB
5 dB

If the indicator light on the selected button flashes, this indicates that the display has been set up to show
SPL values (SETUP, SETUP items► 87) instead of HL.

3.2.13 Microphone
The internal microphone for Talk Over and Speech testing.

Use this microphone as an alternative to the goose neck microphone or the boom microphone on the mon-
itor headset.
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3.2.14 Talk over
Enables communication with the patient who may be sitting in a sound booth. The signal from the internal
microphone or the right Speech microphone is sent to the patient's headset while the button is pressed.

The test signal and any masking signal is interrupted during this period.

When you release the button the test signal returns.

Shortcut functions
When you press and hold TALK OVER (see SETUP items► 87), you can adjust the following:

Talk over shortcut functions

Output level, headphone Left LEVEL selector
Adjusts the output level in the headphone (dB HL).

Fixed dB level, talkover
level

Frequency selector
Switches between the fixed dB level (FIX) displayed and a talkover level related to a
mean of the saved thresholds (THR) for the following frequencies:

250, 500, 1000, 2000 and 4000 Hz.

MIC sensitivity Right LEVEL selector
Sets Mic sensitivity.

Talkover signal to head-
phone

Left/Right arrow button
Controls the Talk Over signal to the right or left headphone. Press twice to transmit the
signal to both ears.

The change-over from "INTERN." to "EXTERN." occurs automatically if an external microphone is connected (see 3.3►
26).

3.2.15 Response indicator
Lights up when the patient presses the patient responder. You will hear a “beep” at the same time.

See The patient responder► 52.

3.2.16 Start/Pause/Stop
Press to Start, Pause or Stop the counter/timer function in different tests as required.

SISI
• Press to Start/Pause and Stop.

HIS
• Press to activate the filters.

22 Otometrics - MADSEN Itera II
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3.2.17 Store/toggle threshold status

Note •This button is not applicable in Speech testing.

Note • In UCL and MCL testing “No response” is not applicable.

Stores a threshold in the internal memory.

• If you press and hold Store, it toggles the threshold status and symbol shown on the display between
“threshold value”, “No response” or no symbol. Release the button when it shows the wanted status.

• You can overwrite a stored threshold value with a new value.

• You can delete an accidentally stored threshold: Press and hold STORE until no symbol is shown.

• If a previously stored threshold is present, it will be replaced by the new threshold when you press STORE.

Change frequency after STORE
• You can set up the Store button to automatically change the stimulus to the next test frequency.

See SETUP, SETUP items► 87.

When you select a frequency and intensity at which a threshold value has previously been found, this value is shown in the
display by means of an "*" symbol beside the frequency indication, and the applicable audiogram symbol beside the level
indication, depending on the selection of ear, masking and transducer type.

3.2.18 Stimulus/masking intensity knobs
Left Level knob

Intensity change
• Changes the intensity for the stimulus signal regardless of whether the signal is being sent to the left

or right ear. Turn clockwise to increase the intensity and counter-clockwise to decrease.

To change this setting, select SETUP, SETUP items► 87.

Masking and intensity
If the masking signal is in locked mode, the intensity of the masking signal is also changed.

Shortcut functions

dB LEVEL left - shortcut functions

Warble modulation Select the warble frequency.

Signal type, SISI The signal type for the SISI test.

Master volume, HIS Master volume value selection in HIS.

Parameter selection, SETUP Parameter selection in SETUP.
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Right Level knob

Intensity change
Changes the intensity of the masking signal in the selected dB steps. To change this setting, select SETUP,
SETUP items► 87.

When you turn the knob clockwise, the intensity is increased and when you turn the knob counter-clock-
wise, the intensity is decreased.

Shortcut functions
You can also use the right LEVEL selector to

dB LEVEL right - shortcut functions

Talkback level Set the level of Talk Back.

Warble modulation, amp-
litude

Warble frequency (in SETUP) and amplitude.

Pulse frequency Pulse frequency.

Impulse time Impulse time.

Input sensitivity, speech Input sensitivity for speech testing.

Word counting method,
speech

Choice of word counting method for speech testing.

Alternating Fowler fre-
quency

Alternating Fowler frequency.

Master volume, HIS Master volume value selection in HIS.

Parameter selection, SETUP Parameter selection in SETUP.

Power out voltage DC POWER OUT voltage.

3.2.19 Stimulus/speech count buttons
Left INT button (FAIL)

Presentation of test signal. This function depends on whether presentation mode is set to normal, or
REVERSE is activated. This is shown by the output indicator (see Signal indicators► 19).

Normally the test signal is present when you press the button.

If you press REVERSE the test signal disappears.

• Speech testing (Stimulus/speech count buttons► 24)
Press this button to count "unheard words" (FAIL).
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Right INT button (PASS)

Usually functions in total parallel with the left INT button.

Use the right INT button to control the masking signal. This will either present or interrupt the masking sig-
nal depending on the setting in SETUP, SETUP items► 87.

• Speech testing
Press this button to count "heard words" (PASS).

• SISI
Use the right INT button to register "Pass" when the patient is unable to use the Patient Response
switch.

3.2.20 Frequency

Change of frequency.
When you turn the knob clockwise, the frequency is increased and when you turn the knob counter-clock-
wise, the frequency is decreased.

Both octave and inter-octave frequencies are available when you use the Frequency knob. The exception is
125 Hz, which follows the setting in SETUP, SETUP items► 87

FREQUENCY shortcut functions

Display graphs, HIS
mode

If you turn this knob in HIS mode, various graphs will be shown (see Hearing Instrument Sim-
ulation (HIS)► 77).

3.2.21 Erase

Note •Switching off the power does not erase stored thresholds from the memory.

This button has several functions:

Deleting all audiogram data
You must delete all data before you start testing on a new patient.

• Press ERASE to clear all data.

To delete all data, press the function key below YES.

To cancel the ERASE command, press the function key below NO.

Additional functions
Speech Audiometry and a number of special tests, various counter values:

• Press to reset to zero.

See the description of Test column► 16, and Special tests► 73),

SISI:

• Press to stop test completely during the pause.
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• Press to delete data at a specific frequency if it is activated during a test (see SISI (Short Increment Sensitivity Index)
► 73).

3.2.22 Xmit
This button is not active.

3.3 Socket connections - rear panel
The socket connections on the back of MADSEN Itera II are protected by a guard, which is hinged onto the front panel and
held shut by a spring-clip at each end. Open this guard in order to connect or disconnect accessories or cables to the back
of MADSEN Itera II.

A. SF (AC), right and left
B. AC
C. BC
D. CD/Tape

E. External microphone/Monitor
headset

F. Monitor
G. Talk back

H. Digital aux.
I. Patient response
J. DC power out
K. RS232 interface

Socket Description

A. SF (AC) Connection for the "SF Transducer output". Here you can connect any headphone
or free field system.

Connect the blue 1/4" jack plug for left (SF Left) and the red 1/4" jack plug for
right (SF Right).

B. AC Connection for the AC transducer to the headphone. Blue 1/4" jack plug for left
(AC Left) and red 1/4" jack plug for right (AC Right).

C. BC Connect the black 1/4" jack plug from the bone conductor.
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Socket Description

D. CD/TAPE Connection of CD or tape recorder - Left (1) and Right (2).

Caution•When you connect other electrical equipment to MADSEN Itera
II, remember that equipment that does not comply with the same safety
standards as MADSEN Itera II can lead to a general reduction in the sys-
tem's safety level.

Note • It is recommended that MADSEN Itera II supplies power to the
CD/Tape player.

E. EXTERNAL
MIC./MONITOR HEADSET

Connection for the gooseneck microphones for speech audiometry or monitor
headset with internal microphone.

F. MONITOR Connection for the monitor head set without internal microphone. Can be used if
a stereo microphone is connected to EXTERNAL MIC./MONITOR HEADSET.

G. TALK BACK Connection for the Talk Back microphone, for communication from patient to
operator. Set the switch on the Talk Back microphone to ON.

H. DIGITAL AUX N/A.

I. PATIENT RESPONSE Connect the black 1/4" jack plug from the Patient Response switch. When the
patient presses the Patient Response switch, this lights the RESPONSE indicator
light and gives an audible "beep" from Itera II.

J. DC POWER OUT Power supply for the CD/TAPE player. Adjustable from SETUP, SETUP items►
87 (OFF and 1.5 - 10 volt DC, 500 mA). Use the right LEVEL selector to select.

Note •Remember to use an adapter if necessary so that the CD has the
correct polarity. The center pin is + and the sheath is 0V.

Note • It is recommended that MADSEN Itera II supplies power to the
CD/Tape player.
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Socket Description

K. RS 232 INTERFACE To connect the device to a PC, use the optional 9-pole PC- RS232 interface cable.

The installation must be carried out in accordance with Medical Elec-
trical Systems in IEC 60601-1 3.1 edition: 2012, ANSI/AAMI ES60601-1
(2005) + AMD 1 (2012) and CAN/CSA-C22.2 No. 60601-1 (2014). The
supplementary provisions on the reliability of electro-medical systems.

It is a general rule for all electrical equipment used in the proximity of
the client that:

• The connected equipment must comply with Medical Electrical
Systems in IEC 60601-1 3.1 edition:2012.

For information on how to use the device with a PC, see Managing Data and Res-
ults► 83.

Supply voltage connection
100-120 V AC, 200-240 V AC, 50/60 Hz, 60 VA
Fuses: 2 T 1 A H/250 V, 5 mm 20 mm.
Before you replace a fuse, first switch off the instrument and disconnect it from
the mains power supply. See Fuses► 101.

3.4 Side panel
Located on the right side of the device.

Power On/Off
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4 Navigating in the OTOsuiteAudiometry Module
The general functions for navigating in the main window are described in the OTOsuite manual.

A. Stimulus marker
B. Work area
C. Control Panel

D. Audiometry toolbar
E. Stimulus bar
F. Masking level indicator

Screen descriptions
You will find descriptions of the actual screens and how to use and view them in:

The Tone test screen► 39
The Speech test screen► 45

4.1 Audiometry Module features

Note •Some of the features below are device-dependent.

With the Audiometry Module, you can
• perform testing while you follow stimulus settings and test progress on your PC display

• view and print test results

• view historic audiometry results from NOAH

• view online audiometry results during testing

• use the Masking Assistant to prompt when masking is recommended

• view the masking level indicator in audiogram

• view audiogram overlays

• enter tester details and test date entry for manually entered audiograms

• enter special test and tuning fork test results

4.2 The Audiometry Module menu system and toolbar

General icons
See the OTOsuiteUser Guide.
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Audiometry icons andmenu selections
The icons and menu selections that are unique to Audiometry functionality depend on the test functions included in OTO-
suite and/or whether a test device is connected.

Audiometry icons

Tone audiometry

Speech audiometry

4.2.1 File menu
Menu item Icon Description

New Audiogram Select new audiogram. You will be prompted to save or cancel current data.

4.2.2 Edit menu
Menu item Shortcut Description

Audiometric prop-
erties...

Ctrl+U Click to enter Tester name, Test Date, and air conduction transducer for a manu-
ally entered audiogram.

Note •The air conduction transducer is stored when you have selected it
in the transducer section of the Control Panel (or with device controls, if
applicable) and data points are entered on the audiogram.

4.2.3 View menu
Menu item Icon Description

Masking Assistant Enable or disable the Masking Assistant.

The Masking Assistant causes an unmasked threshold to flash
repeatedly if masking is recommended.

• See The Masking Assistant► 33.
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Menu item Icon Description

Overlays Enables or disables the overlays. Overlays display

• pictures

• severity

• speech banana,

• speech letters,

• unusable area

on the audiogram.

Overlays can also be displayed by selecting them from the overlays
box below or next to the audiogram.

To view/hide the overlays box, select Tools > Options > General.

Combined Audiogram Click to toggle between viewing both ears in a single audiogram (com-
bined audiogram) or both a left and a right audiogram on your
screen.

Combined View
• Click to view both ears in a single audiogram.

Split View
• Click to view separate audiograms for each ear.

Left - Right Click to display the left ear audiogram on the left side of the window
and the right ear audiogram on the right side of the window (when
Dual Graph View is enabled in Options > Audiometry > Tone >
Misc).

Right - Left Click to display the right ear audiogram on the left side of the win-
dow and the left ear audiogram on the right side of the window
(when Dual Graph View is enabled in Options > Audiometry >
Tone > Misc).

Audiogram Legend Click to enable or disable the display of the audiogram legend. The
legend contains the most commonly used symbols for the audiogram.
It is not configurable.
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Menu item Icon Description

Standard / All / High
frequencies

The graph shows up to 20,000 Hz. MADSEN Itera II presents stimulus
up to 12,500 Hz.

• Click to choose between viewing:

Standard Frequencies
Displays the audiogram from 125 to 8000 Hz.

All Frequencies
Displays the audiogram from 125 to 20,000 Hz.

High Frequencies
Displays the audiogram from 8000 to 20,000 Hz.

Select Orientation Click to select the perspective of the patient's ears as presented on
the screen for graph and table views.

Scoring and Playing See Speech testing► 67.

4.2.4 Tools menu
Menu item Description

Curves and Symbols Click to select the Curves and Symbols dialog box.

This dialog box and its related function are specific to configuring the curves and symbols to
be displayed on the audiogram or speech graph during testing.

See Curves and symbols selection► 41.

Options... See description of how to work with user options and User Tests in the OTOsuiteUser Guide.

Additional icons

Menu item Description

Import Audiometry
Data

Click to import audiometry data from AURICAL Plus and MADSEN Conera. See the OTO-
suiteUser Guide.

4.3 The Patient Responder indicator
When the patient presses the Patient Responder this is shown on the Stimulus bar, and a sound signal from the PC is heard
through the Monitor Speaker or Operator Headset. The sound signal is optional (Tools > Options > Audiometry >
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General > Measurement, Misc > Audible patient response).

Use the Configuration Wizard to select Single Responder or Dual Responder setup. See Configuring the Audiometry Mod-
ule► 99.

Single Responder setup

• Green
Indicates that the patient is pressing the Patient
Responder.

Dual Responder setup

• Red
Indicates that the patient is pressing the right
response button.

• Blue
Indicates that the patient is pressing the left
response button.

• Red and blue
Indicates that the patient is pressing both response
buttons.

4.4 The Masking Assistant
If the Masking Assistant is enabled, it will at all times check for frequencies that may require testing with
masking. This also applies to old audiograms imported from NOAH or XML as long as a supported transducer
was stored with the data.

The Masking Assistant is a tool provided to help you with an indication that there may be frequencies where testing with
masking1 is recommended.

• The audiogram symbol will flash at the specific frequencies where contralateral masking may be recommended2.

1(Katz, J., Lezynski, J. (2002). Clinical Masking. In J. Katz, ed., Handbook of Clinical Audiology, Williams and Wilkins, Bal-
timore.)
2Based on criteria described in Clinical Masking, Essentials of Audiology, Stanley A. Gelfand, Thieme 1997, andMeas-
urement of Pure Tone Hearing Thresholds, Audiologists’ Desk Reference - Vol 1, James W. Hall III, H. Gustav Mueller
III, Singular Publishing Group 1997. andMunro K.J., Agnew N. A comparison of inter-aural attenuation with the Ety-
motic ER-3A insert earphone and the Telephonics TDH-39 supra-aural earphone. Br J Audiol 1999; 33: 259-262.
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• The masking criteria are configurable so that you can
set them up to match your local recommendations for
masking. You can for instance choose either frequency
specific criteria, which increases the efficacy of your
work, or the traditional "one-level-fits-all" criteria.

Select the Tools > ConfigurationWizard > Audi-
ometry - Configure...  > Masking Assistant to set up
the masking criteria.

All masking signals are calibrated in effective masking.

How does the Masking Assistant work?

Terminology

AC AC test ear

ACc AC contra

BC BC

BCc BC contra

Min IA Minimum inter-aural attenuation.

When ismasking required?

Masking is recommended when the following conditions are met:

AC AC > ACc + Min IA

or AC > BCc + Min IA

BC BC < AC - x* dB

Only stored thresholds measured without masking are checked. Levels which did not evoke a response are excluded from
the check. This means that as soon as a masked threshold has been stored, the flashing stops for that frequency.

* denotes configurable Air/Bone gap criterion (Tools > ConfigurationWizard > Audiometry - Configure... > Masking
Assistant).

Min IA is frequency specific
These are the Min IA tables for TDH-39 and Otometrics Inserts used in the Masking Assistant 1.

1Katz, J., Lezynski, J. (2002). Clinical Masking. In J. Katz, ed., Handbook of Clinical Audiology, Williams and Wilkins, Bal-
timore. Munro, K.J., Agnew, N. A comparison of inter-aural attenuation with the Etymotic ER-3A insert earphone and
the Telephonics TDH-39 supra-aural earphone. Br J Audiol 1999; 33: 259-262. Hall, JW., MUELLER, HG. (1997). The audi-
ologists’ desk reference, Volume I., Singular Publishing Group, San Diego.
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Min IA (supraaural phone: TDH-39), frequency specific

Hz dB
125 35 Katz & Lezynski, (2002)

250 48 Munro & Agnew, BJA (1999)

500 44 Munro & Agnew, BJA (1999)

750 40 N/A - fulfill traditional approach

1000 48 Munro & Agnew, BJA (1999)

1500 40 N/A - fulfill traditional approach

2000 44 Munro & Agnew, BJA (1999)

3000 56 Hall J.W. III & Mueller G.H. III / Munro & Agnew, BJA (1999)

4000 50 Katz J / Munro & Agnew, BJA (1999)

6000 44 Hall J.W. III & Mueller G.H. III / Munro & Agnew, BJA (1999)

8000 42 Katz J / Munro & Agnew, BJA (1999)

Min IA insert phone

Hz dB
125 60 N/A - traditional value

250 72 Munro & Agnew, BJA (1999)

500 64 Munro & Agnew, BJA (1999)

750 60 N/A - traditional value

1000 58 Munro & Agnew, BJA (1999)

1500 60 N/A - traditional value

2000 56 Munro & Agnew, BJA (1999)

3000 58 Munro & Agnew, BJA (1999)

4000 72 Munro & Agnew, BJA (1999)

6000 54 Munro & Agnew, BJA (1999)

8000 62 Munro & Agnew, BJA (1999)

4.5 The Audiometry Module Control Panel
Click the Control Panel icon in the toolbar to activate the Control Panel.

Note •The appearance of the Control Panel depends on the test device used.

The general function of the Control Panel is described in the OTOsuiteUser Guide.

The Audiometry Module Control Panel shows the settings selected on the connected audiometer for the specific test.
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Fig. 1 The MADSEN Itera II Control Panel

4.5.1 The Control Panel
When you activate the OTOsuite Audiometry Control Panel, MADSEN Itera II automatically connects to the audiometer.

Note •You cannot operate MADSEN Itera II from the Control Panel.

The Control Panel is divided into a number of sections where you can view various settings, and a section for controlling
communication with the audiometer.

Stimulus The Stimulus panel shows the stimulus type used and the selected test ear.
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Masking The Masking panel shows the masking used and the selected test ear.

Test The Test panel shows the test type used.

Connection
Note • If there is a risk that patient selected in the audiometer does not correspond with
the patient shown in OTOsuite or NOAH status bar, a warning triangle will be shown on
the screen.

• Make sure that you select the correct patient, either in the audiometer or in OTOsuite.

4.6 The stimulus bar

A. Intensity
B. Stimulus indicator
C. Transducer indicator
D. Stimulus being presented

E. Frequency
F. Stimulus bar color
G. Routing indicator
H. Masking on

Intensity

Indicated by the dB level above the channel status bars.
• Masking is denoted by square brackets around the level (calibrated in effective masking level).

• The green triple wave symbol above the level indicates that the stimulus is currently being presented.

Stimulus bar color

Indicates the routing for each channel:
• Blue = left ear

• Red = right ear

• Blue/Red = binaural

• Gray = unspecified

Stimulus, transducer and routing indicators

The stimulus/masking type, the transducer and the routing for each channel.
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4.6.1 The Tone stimulus bar

A. Symbol B. Frequency

During online testing, the stimulus bar shows:

Symbol

• Indicates the symbol that will be displayed on the audiogram(s) when a data point is stored. The symbol shown
reflects the current audiometer measurement settings.

See also Curves and symbols selection► 41.

Frequency

• Indicated by the Hz value in the center of the stimulus bar.

4.6.2 The Speech stimulus bar

A. VU meter
B. Speech score
C. Word count

During online testing, the stimulus bar shows:

Speech Score/Word Count

• Displays the percentage correct/incorrect and the amount of words correct/incorrect out of a given number of
words. You can display speech score and word count either as “% Correct” or as “% Incorrect”. To set your pref-
erence, select Tools > Options > Speech > Misc. > Score Presentation.

% Correct is the default setting.

38 Otometrics - MADSEN Itera II

4 Navigating in the OTOsuiteAudiometry Module



VU Meter

• Displays the level (in volume units) of the test microphone or speech material from Source A or Source B. Speech
should always be delivered at 0 dB on the VU meter so that the dB level on the stimulus intensity bar represents
the level actually being delivered to the patient.

4.7 The Tone test screen
During online testing, the screen reflects the test done by the audiometer as it progresses.

A. Stimulus bar
B. Work area
C. Legend box

4.7.1 The work area in the Tone screen
The Tone test work area consists of a range of elements for viewing and selecting various features:

• The audiogram► 39

With a description of audiogram elements, how to view single or dual graphs, and how to view the intensity levels
used for masking.

• The Legend box► 43

With a description of result boxes for special tests, utilities such as a timer and an overlays selector, and instructions
for how to view/hide the feature boxes.

4.7.2 The audiogram
Audiogram elements

Cross hatch

Indicates your current stimulus level and frequency. The color indicates the rout-
ing:
• Blue = left

• Red = right

• Black = binaural
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Mouse cursor

Indicates where you place the mouse. The color indicates the routing:
• Blue = left

• Red = right

• Black = binaural

Audiogram

• Intensity is shown to the left of the audiogram in dB HL.

• Octave frequencies are shown below the audiogram in Hz.

• Interoctave frequencies are shown above the audiogram in Hz.

Viewing the audiogram
You can choose between:

Single graph view

A. Stimulus marker (ear color)
B. Masking level indicator
C. Mouse cursor (ear color)

40 Otometrics - MADSEN Itera II

4 Navigating in the OTOsuiteAudiometry Module



Dual graph view

When you use the dual graph viewing option, the graph that
corresponds with the stimulus ear will have a gray outline to
denote the active audiogram.

You can switch the position of the right and left graphs to cor-
respond to your viewing preference.

1. Select Tools > Options > Tone > Misc. > Dual Graph View
or in the menu bar under View.

A. Stimulus marker (ear color)
B. Masking level indicator

Viewingmasking levels

Masking levels

Below the audiogram, the intensity levels used for masking can be displayed. It is an option to display the masking
levels. Select Tools > Options > Tone > View > Misc. > Masking Levels.

• In combined view, the non-test ear masking levels are shown below the graph.

• In Dual Graph View, the masking level used for masking the non-test ear is by default displayed under the graph
for the test ear. The masking level can be set to be displayed either under the test ear or under the non-test ear:
select Tools > Options > Tone > View > Misc > Masking Table Placement.

4.7.3 Curves and symbols selection
You can select a symbol and/or a curve style for a specific measurement and you can create new symbols.

4.7.3.1 Selecting a symbol or curve
You can select a symbol and/or a curve style for a specific measurement.

1. Select Tools > Curves and Symbols...

2. Click on the selections that apply to your measurement under Test, Transducer, and Aided Condition. The current
symbols and line style are shown.

3. Double-click on the symbol you wish to change. The Symbols selection dialog box is shown.
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4. Double-click on the symbol you wish to use.

5. To change the line style of the curve, select from the Line Style drop-down list.

6. To change the color, double-click on the current Color square. Select a new color or click on Define custom colors>>
to select a color not shown. Click OK.

7. To optimize viewing of the audiogram, you can offset the symbols in relation to the audiogram grid in the fields Hori-
zontal Offset and Vertical Offset.

You can superimpose symbols on the audiogram where two different points share the same value (i.e. air and bone
threshold). In order to see both superimposed symbols, you can define an offset direction for each individual symbol.

4.7.3.2 Creating new symbols
1. Use Microsoft Powerpoint to create graphics that can be saved in Enhanced Meta Files (*.emf) format.

2. The outer size of the EMF file must be less than or equal to 1 x 1 inches (2.5 x 2.5 cm).

Note • If the symbols are created larger, this may severely compromise the performance of OTOsuite.

The standard symbols are drawn within a centered inner frame of 1.5 x 1.5 cm (0.6 x 0.6 inches).

The area between the inner and outer frames is used for additions to the main symbol, such as arrows for No
Response or Response at Limit, and designators for Aided Left or Aided Right.

3. Before you store the new graphic, make sure that the outer and inner frames are invisible: Select the frame, and set
the line color to No Line. Repeat this for each frame.

4. To save as an *.emf graphics file, select all elements in the drawing (including the invisible outer frame as well as the
symbol itself centered within the frame). Right-click and select Save as picture...

5. Name the file and select the file type *.emf.

6. Save it in C:\Program Files\GN Otometrics\OTOsuite\AudSymbols.

7. Launch the OTOsuite Audiometry Module and select Tools > Curves and Symbols.

The new symbol should appear on the list of symbol options.

In this dialog box, you also have options for setting the color, line type, and horizontal and vertical offsets that will
apply when you use the new symbol.
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4.7.4 Compare audiograms
Make sure the feature box for Compare Audiograms is visible in the OTO-
suite main view area (if not, set Tools > Options > Tone > View > Show
Compare Audiograms to On).

OTOsuite under NOAH
All sessions relating to the selected client, and containing audiometry data are automatically loaded into the Compare
Audiograms feature box.

Compare current and historical audiograms

1. In the Compare Audiograms feature box, single-click to select
the audiograms you wish to view from the list of historical audi-
ograms. Any selected historical audiogram will appear with grey
curves in the audiogram graph.

2. All curves of the selected audiograms are viewed and compared
simultaneously unless you explicitly select a curve type from
the feature box drop-down lists. The lists let you define the test
type and aided condition that you wish to view and compare.

3. You can enhance the compare view by enabling the Difference
view. This is done by checking the Difference option in the fea-
ture box. The Difference view highlights any difference
between the most recent and any older audiogram curves selec-
ted in the list.

4. If you decide to make a new audiogram, then a new Current audiogram is generated in the Compare Audiograms fea-
ture box list, and what was previously the current audiogram consequently becomes a historical one, displayed with
measurement date.

5. If you deselect the viewing of a Current audiogram so that it is no longer shown, then it will instantly be reselected if
you try to edit a curve.

6. You can keep any previously collected audiogram visible in the graph while collecting the current audiogram simply by
keeping it selected in the Compare Audiograms feature box while measuring.

4.7.5 The Legend box
The Legend box shows the audiogram symbols used in the graphs.

4.7.6 Tone view options
You can access a number of Tone view options directly from the Tonemain screen.

The view options can be turned on/off. To do so, select Tools > Options > Tone.
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Overlays

Select the overlay to be displayed on the audiogram.

These overlays assist in the counseling process.

• Select Tools > Options > Audiometry > Tone > Overlay Selection Box.

The overlay options are:

Pictures

Displays pictures representing common environmental sounds at their approx-
imate dB level (e.g. bird, plane).

Severity

Displays the audiometric severity levels (normal, mild, moderate, moderate-to-
severe, severe, profound).

Speech Banana

Displays the speech banana of a listener with normal hearing.

Speech Letters

Displays speech sounds at their approximate dB level.

Unusable area

Shades the area which is outside the patient's dynamic range of hearing.
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4.8 Work-flow related features

4.8.1 Selecting orientation
Select graph, table and control layout

Click Select Orientation on the toolbar to see the following dialog:

Graphs and Tables Click to select the way you view the patient in relation to your mon-
itor.

Control Click to select the position of the stimulus channel on the screen.

4.8.2 Ear shift frequency and level setting
When you change test ear, you can define that the frequency and level should be set to 1000 Hz at 20 dB HL. To do so,
select Tools > Options > Tone > Measurement > Ear Shift Frequency and Level. Check Ear Shift Frequency and Level.

4.9 The Speech test screen
During online testing, the screen reflects the test done by the audiometer as it progresses.

A. Stimulus bar
B. Work area, tabular view
C. Audiogram
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4.9.1 The work area in the Speech screen
Selecting tabular or graphical view
In the Speech test screen of the OTOsuite Audiometry module you can use either tabular view or graphical view.

1. To select the view you wish to use, select Tools > Options > Audiometry > Speech > Speech View Mode > Tabular
View or Graphical View.

The work area can be shown in two modes:

• Speech testing - tabular view► 47

• Speech testing - graph view► 48

4.9.2 Speech feature boxes
You can access a number of speech display options directly from the Speechmain screen.

Feature boxes

Pure Tone Data Displays the pure tone average for air conduction and bone conduction as well as the articulation
index.
• To configure pure tone average (PTA) calculation, select Tools > Options > Audiometry > Gen-

eral > Misc. > PTA Frequency AC/BC.

• The AI is calculated according to the “Count-the-dot” method.

Stenger Displays the results of a speech Stenger test (optional).
• Scoring options are positive (+) or negative (-).

4.9.3 Terms and abbreviations used in Speech testing
SDT Speech Detection Threshold

SRT Speech Recognition Threshold

MCL Most Comfortable Loudness Level

UCL UnComfortable Loudness Level

WRS/SRS Word Recognition Score/Sentence Recognition Score

• Score
Percentage of correct/incorrect words.

• Level
dB level at which the words were presented.

• [Msk]
Effective masking level (dB EML) used for contralateral masking.

• SNR
Signal-to-Noise Ratio.
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PTA Pure Tone Average

• PTA - AC
Pure Tone Average for Air Conduction thresholds.

• PTA - BC
Pure Tone Average for Bone Conduction thresholds.

AI Articulation Index (%), based on the Count-the-dot method.

4.10 Speech testing - tabular view
MADSEN Itera II is intended for use with predefined speech pro-
tocols that are loaded automatically when you select a user test.

You can have a full overview and instantly select measurement
type, ear, transducer, stimulus type, routing, and speech material.

• If you wish to make manual changes on the fly, use the control
panel to select.

The predefined tests are incorporated as rows in the speech table.

• To select a predefined test, simply click the button in the Test colum. This will load all the speech settings and speech
material.

If you perform a test which is not available in a predefined Speech table, a speech row is created automatically. This tem-
porary row will exist as long as there is stored test data for that measurement setup.
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4.11 Speech testing - graph view

General description

The Speech Graph screen displays the speech graph which includes SDT, MCL, UCL noted by a line (blue = left, red = right)
at the corresponding dB level.

For SRT and WRS/SRS, or WRS/SRS with noise, symbols will be shown based on the location corresponding to the dB level
of presentation and the percentage of correct responses.

The graphical speech legend
The graphical speech legend shows the measurement conditions for testing and displays the corresponding symbols from
the graph. The legend rows are color coded according to their respective routing.

The legend adapts to the tests and adds a row for each measurement you make. You can also pin tests so that they are
readily available for future testing.

Adaptive rows
The rows in the adaptive legend always show the current measurement settings and the measurements you have made. A
new row will be added to the legend every time you make a new test.

Example

The adaptive Speech legend showing the current measurement settings. Data has not been stored at this point.

The adaptive Speech legend showing the three first measurements followed by a blank row with the current measurement
settings ready to be stored.
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Pinned rows

You can pin a row to make it available in advance in order to reflect the measurements usually performed in your clinic. A
legend with pinned rows will always look the same when you start testing a new patient.

This customized layout provides you with a consistent work environment and makes it easy to see what to do next, or if
any test has been deliberately left out.

A test that is not pinned to the legend is added automatically below the pinned rows.

Click 'n' Get
The Click 'n' Get feature allows you to perform a test from the predefined legend simply by clicking the Apply Settings
arrow button in the second column of the legend. Click 'n' Get loads all the relevant settings including the integrated
speech files.

Pinning a test
You can pin one test per measurement condition.

Note •You can pin a test to the legend, if you have not already pinned an identical test. To edit a pinned test,
make sure that User Tests are not write protected in the Configuration Wizard.

To pin a row, simply select the row, right-click and select Pinned Tests > Pin Test. Here you can also rearrange pinned
rows by moving them up or down in the legend.

Modifying Click 'n' Get for a pinned test
You can assign a different speech stimulus and/or transducer to a pinned test. This will load the desired word list, trans-
ducer, etc., when you use the Click 'n' Get feature.

Changing assigned speech stimulus for a pinned test
1. Select the speech stimulus, such as a specific integrated word list, or internal CD or line-in device, in the Control Panel

and/or speech player.

2. Right-click on the Apply Settings button in the pinned test row, and select Assign Selected Stimulus.

Changing an assigned transducer for a pinned test
1. Select the transducer in the Control Panel.

2. Right-click on the Apply Settings button in the pinned test row, and select Assign Selected Transducer.
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Note •When you use Click 'n' Get to apply settings, the AC transducer as well as the speech stimulus are loaded
as your preferred starting point. You can always adjust them in the Control Panel or in the Speech Player panel.

Example 1:
You typically use insert phones but you have a patient with an ear infection and you wish to use supra-aural head-
phones. Use Click 'n' Get to load the desired test, and simply switch to Phone in the Control Panel before you
start the test.

Example 2:
You typically wish to start the Speech test by familiarizing the patient with a specific word list before starting the
actual test with a different word list. Use Click 'n' Get to load the desired starting point, and simply switch to any
word list you wish to use after the familiarization.

Storing data in a row
To store data in a row, click the dB field in the relevant row or press S on your keyboard.

The Info field
The Info field provides additional information such as a stimulus source (e.g. CD, Live, File, or specific speech material), as
well as noise condition, and your own comments if desired. To add your own comments, right-click the Info field.

Editing a row
Click on the data you wish to edit and use the right-click menu to change the value.

Deleting a row
Right-click on the field you wish to delete and select Delete Measurement.
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5 Preparing for testing
It is important to prepare properly before making measurements with MADSEN Itera II and the OTOsuite software. It is
time-saving for both you and the client if the environment, the client, the test device, and the software are ready for the
test.

5.1 Preparing the test environment
Before you start testing, make sure that the test environment is conducive to testing.

• The test environment should be quiet, preferably in a sound proof booth, for accurate threshold results.

• The test room or sound booth should have a minimum of furniture and hard surfaced articles (i.e. filing cabinets, tables
etc), as these can cause reverberation during sound field testing.Live voice examinations are best carried out when
using a sound booth, so that the client/patient cannot hear the tester's voice directly. With tester and client/patient
in the same room, especially of clients with normal or almost normal hearing, false results could be obtained.

Furniture
The test environment should include

• a comfortable chair for the client,

• a child-sized chair if testing pediatrics,

• a comfortable chair for the assistant.

The examiner should be able to see the client/patient. The client/patient should be seated so that it is not possible to see
what the examiner is doing or how the equipment is being operated. This reduces the likelihood that the client/patient
can anticipate when the stimulus will be presented.

For pediatric testing consider using a highchair, which is a familiar environment for most children and will place them
closer to eye level with the visual reinforcement toys. Make sure if performing visual reinforcement audiometry that the
reinforcing toys can be seen by the child. A child cannot look over and up at a toy until approximately 9 months of age.

Lighting
The lighting in the booth should be bright enough for the examiner to adequately see the client.

Toys
If testing pediatrics, several interesting toys are needed to center the child (obtain the child's attention toward the assist-
ant or tester) prior to stimulus presentation. It is best if these toys do not produce sounds.

The child should be conditioned to respond to the sound of the stimulus only. Competing sounds from toys can confuse
the child and reduce the reliability of the test.

Soft toys are needed to keep a young child's attention during behavioral observation or visual reinforcement audiometry.
Younger children like to tap the toy on the highchair tray and therefore a toy that does not create much sound would be
more appropriate during testing.

Blocks, buckets, puzzles are needed to keep a child's attention during play audiometry.

5.2 Preparing the test equipment
Make sure that you have connected the required accessories:

• headphones. To connect, see Air conduction► 104.

• insert phone(s). To connect, see Air conduction► 104.

• bone conductor. To connect, see Bone conduction► 105.

• external microphone. To connect, see External microphone► 105.
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• free field equipment. To connect, see Free Field► 105.

• patient responder (Socket connections - rear panel► 26).

5.2.1 Connecting the cables of the test equipment
Connect the cabling of the computer and various accessories as shown in the following

USB/RS232 connection
For PC or Laptop with USB port or RS232 cable for PC or Laptop with serial port.

A. Patient responder

Free-field
See Free Field► 105 for a description of how to connect to MADSEN Itera II.

5.2.2 The patient responder
• Place the patient in a sound booth, if one is available, and facing away from MADSEN Itera II.

• Instruct the patient in how to use the patient responder.

• Instruct the patient in pressing the button even if only weak signals are heard.

Note •During automatic testing, if the patient presses the switch repeatedly during a stim-
ulus presentation, the response is ignored.

Note •During automatic testing, if the patient does not release the switch, a beep is issued in the headphones. If
this situation is repeated, the test is paused. Reinstruct the patient.

• Before testing, check that the Response indicator lights up when the patient presses the responder.

52 Otometrics - MADSEN Itera II

5 Preparing for testing



5.2.3 Preparing for air conduction testing
Headphones, insert phones
Make sure that the headphones and insert phone(s) are properly connected.

Connection to the device
See Installation► 103 for a description of how to connect headphones and insert phones to the device.

Fitting on patient
• Place the patient facing away from the device, in a sound booth, if one is available.

• Set the switch on the Talk Back microphone to ON and set the level of Talk Back (Input - MIC, CD, REVERSE► 18).

• Fit the headphones on the patient, with the red phone on the right ear.

• Choose the ear with the better hearing to be tested first.

Instructing the patient
• The patient will be hearing brief tones.

• The tones may at times appear to be very weak.

• Instruct the patient in how to use the patient responder (The patient responder► 52).

• The patient should press the patient responder as soon as the tone is heard, even if it is very weak.

5.2.4 Preparing for bone conduction testing
Make sure that the bone conductor is properly connected.

Fitting the bone conductor on the patient
When you fit the bone conductor on the patient:
• Instruct the patient in what you are about to do.

Note •The bone conductor cable and insert phone cable must not be removed or tampered with while
MADSEN Itera II is powered on. Either disconnect the bone conductor or insert phone entirely from the
instrument, or make sure that the instrument itself is disconnected from the power source.

• If a sound booth is not available, place the patient facing away from MADSEN Itera II. This is to avoid visual
clues during testing.

• If applicable, set the switch on the Talk Back microphone to ON and set the level of Talk Back.

• Position the bone conductor/vibrator so that it rests comfortably against the mastoid bone (behind the ear)
and is not in contact with the pinna, or against the patient’s forehead.

• If MADSEN Itera II is calibrated for this, see SETUP, SETUP items► 87 to choose between Forehead and Mastoid,
depending on the preferred placement of the bone conductor.

Testing with masking
If you intend to use masking, either use the mono insert phone (recommended) or fit the headphones so that the red
(right) phone is applied to the poorer ear for masking, and the other phone is applied to the patient's temple region, leav-
ing the test ear uncovered.
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Important•The masking transducer must not under any circumstances block or cover the bone conduction test
ear. If it does, this will invalidate the test due to the occlusion effect.

Make sure that there is no contact between the headband, which holds the bone conductor in place, and the headset
or headband supporting the headphones. This will prevent vibrations from being conducted from one to the other.
Leave it in this position until the test is finished.

Instructing the patient
• The patient will be hearing brief tones.

• The tones may at times appear to be very weak.

• The tones can be heard either in the one ear, in the other ear or in both ears simultaneously.

• Instruct the patient in how to use the patient responder.

• The patient should press the patient responder as soon as the tone is heard, even if it is very weak.

• You may prefer that the patient indicates in which ear the tone was heard by raising a hand.

• The patient should not touch or move the bone conductor from its position.

5.2.5 Preparing for testing with masking
See Air conduction with masking - suggested procedure► 64 for a recommended procedure on testing with masking.

Instructing the patient
• In addition to the tones in the test ear, the patient will be hearing a noise in the other ear.

• The tones can be heard in either ear.

• The patient should respond to the tones in the test ear and ignore the noise.

• The patient should press the patient response switch as soon as the tone is heard.

• You may prefer that the patient raises a hand to indicate in which ear the tone was heard. This is particularly relevant
since masked testing is used to determine that the signal is perceived by the test ear.

5.3 Listening check
Perform listening checks routinely to make sure that the equipment is functioning properly.

• Use a person who has auditory thresholds below 10 dB and make sure that he or she can hear a very faint sound for
each stimulus type, frequency and for each transducer at 0 to 5 dB.

• If the person cannot hear the stimulus, contact the manufacturer or local representative to troubleshoot the system.

• It is recommended that the system be calibrated annually or according to the local requirements.

5.4 Preparing the client

Previous exposure to high levels of sound
If the patient has been exposed to high levels of sound, this may create a temporary threshold shift (TTS), which will dimin-
ish with time. If the patient is tested soon after this type of noise exposure, it may not be possible to determine the nor-
mal hearing threshold. It is recommended that a minimum of 16 hours should pass between exposure and testing.
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Explaining the test procedure
• Explain how the test will be done, including which ear will be tested first.

• Describe what the presented signals may sound like.

• Explain what the patient will be expected to do. This includes using the Patient Response Switch and responding to
the presented signals/speech.

5.4.1 Hygienic precautions
It is important that hygienic precautions are taken to protect the client from cross-infection. Be sure to follow any estab-
lished infection control procedures for the setting in which you are working.

• Headphones

Clean the headphones between patients, e.g. with a non-alcohol based antibacterial wipe, such as Audiowipes.

• Insert earphones

Warning•To prevent cross-infection, use new eartips when you test the next client.

5.4.2 Inspecting the client’s ear(s)
1. Position the client so that you can easily access the client’s ear(s).

2. Grasp the pinna and gently pull it back and slightly up and away from the client's head.

3. Inspect the ear canal and make sure that you can see the ear drum.

If you can see apparent narrowing of the ear canal, it may be blocked by vernix or debris, or it may not be straight.

4. If the ear canal is blocked, for instance by vernix or debris, the outcome of the procedures may be affected.

Clean the ear canal if required.

5.5 Preparing the Audiometry Module for testing

MADSEN Itera II and the Audiometrymodule
• Make sure the cables of the test equipment are connected correctly.

• Launch OTOsuite and the Audiometry module on the PC (see the OTOsuite User Guide).

• Make sure MADSEN Itera II is switched on.

• Make sure the connection between the Audiometry module and MADSEN Itera II is enabled.

Fetch multiple test results
• If you have done off-line testing with MADSEN Itera II, you can fetch test results from the audiometer.

See Transferring test results from the audiometer to the PC► 83.

Test types
• Manual air conduction testing

To perform manual air conduction testing, see Tone testing► 59.

• Bone conduction testing
To perform bone conduction testing, see Bone Conduction threshold test► 60.
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• Speech testing
To perform speech testing, see Speech testing► 67.

• Special tests
MCL tone testing► 73
UCL tone testing► 73
SISI (Short Increment Sensitivity Index)► 73,
ABLB (Alternate Binaural Loudness Balance)► 75,
STENGER Test► 76,
Hearing Instrument Simulation (HIS)► 77

These tests are optional. To add any of these tests to your configuration, contact your local supplier.

5.6 Proper transducer placement

Headphones
1. Loosen the headband and place both the left and right side of the headphones simultaneously.

2. Make sure that the blue indicator is on the left ear and the red indicator is on the right ear. The center of the head-
phone diaphragm should be directly opposite the opening of the ear canal for the left and right side.

Note • If the headphones are not placed properly, there is risk of causing the ear canal to collapse which will res-
ult in elevated thresholds.

3. Ask the patient if the headphones are comfortable.

4. Tighten the headband while holding the headphones in place with your thumbs.

5. Examine the placement of the headphones to make sure they are level, and properly positioned.

Insert Earphones
Young children tolerate insert earphones better than headphones.

The insert earphones are color-coded:
• the blue indicator for the left ear,

• the red indicator for the right ear.

1. Select the largest foam eartip that will fit into the patient's ear.

If the eartip is too small the sound will leak out and the dB level will not be accurate at the eardrum.

Insert earphones have greater attenuation between ears especially at the low frequencies; this reduces the need for
masking.

2. It is best to clip the insert earphone transducers behind the child or on the back of their clothing and then fit the
foam eartip into the child's ears.

If the foam eartip is a little too large, consider cutting it down to make it a little smaller.

Bone Oscillator

Note •For unmasked bone thresholds, you can store binaural data:
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Note • If there is a difference of 10 dB or greater between the bone conduction threshold and the air conduction
threshold of the same ear, masking is needed. The Masking Assistant can assist you in determining which
thresholds need to be masked.

Note • If the SRT of the test ear and the SRT or PTA of the nontest ear differ by 45 dB or more, masking is
needed.
If the SRT of the test ear and the bone conduction PTA of the nontest ear differ by 45 dB or more, masking is
needed.

Mastoid placement
1. Move any hair covering the mastoid out of the way and place the flat round part of the bone oscillator securely on the

boniest portion of the mastoid without any part of the transducer touching the external ear.

2. Make sure the bone oscillator is tight on the mastoid but still comfortable.

3. If you are going to perform masking with earphones, position the other end of the bone oscillator headband over the
patient's temple on the opposite side of the head so that the headband of the earphones and bone oscillator fit on
the patient's head.

Frontal bone placement
1. For frontal bone placement, place the flat round part of the bone oscillator securely on the middle of the forehead

about an inch (2.5 cm) below the hairline.

2. Make sure the bone oscillator is tight on the forehead but still comfortable.
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5 Preparing for testing
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6 Tone testing

6.1 Air Conduction threshold test
Modified (ascending) Hughson-Westlake.

Prerequisites
• Press TONE.

• Press AC.

• If needed, select WARBLE or PULSE as stimulus type(an advantage when you test children).

• If you want to predefine the duration of the signal presentation when you press the INT button, press IMPULSE.

• If you wish to use masking, select the masking type: PressMASK ON. See also Testing with masking► 62.

• If required, turn the FREQUENCY knob to set the starting frequency: The typical starting frequency is at 1000 Hz.

The signal is usually presented for each tone in the following order:

1000 Hz and increasing frequencies
followed by
1000 Hz (cross check) and decreasing frequencies.

• Set the initial level of the presented signal to an audible level: Turn the LEVEL knob to 40 dB HL.

This is to familiarize the patient with the test signal. Other familiarization procedures may be preferred.

• Test the better ear first. If this is unknown, start with the right ear. Press L<-->R to select the ear you wish to test.

• Give the Patient Responder to the patient and explain how it should be operated (see The patient responder► 52).

6.1.1 Testing
1. Press the INT button (right or left) to present the tone to the patient for 1 to 1.5 seconds.

2. Use the corresponding LEVEL knob to set the intensity to approx. 20 dB above the patient's presumed threshold.

If the patient does not respond to the presented signal, turn the LEVEL knob to increase the signal level in steps of
10 dB until the patient responds.

3. Reduce the signal level by 20 dB until the patient does not respond to the signal.

4. Increase the signal level in steps of 5 dB and present the signal to the patient at each level until the patient responds
to the signal.

5. Reduce the signal level by 10 dB and present signals at levels increased by 5 dB until the patient responds.

6. Repeat item 5, 1 to 3 times until the patient has responded 3 times at the same level.

This level represents the hearing threshold at 1000 Hz based on 3-5 ascending series.

In some situations, it may be satisfactory with two responses at the same level.

If the patient has responded less than 3 times at the same level after 5 series, present a signal at 10 dB above the level
where a response was last registered.

Then repeat item 6.

7. When the threshold is determined, press STORE to store that particular threshold. See Store/toggle threshold status
► 23.

8. Select the next frequency.

You can link the Store and Next Frequency functions, so that the test progresses with the next frequency when you
press STORE. See SETUP items► 87.
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9. Continue to use the right and/or left LEVEL knob to increase/decrease intensities until you have determined all
thresholds.

Note • If the thresholds measured at 1000 Hz in the ear differ by 10 dB or more, even the other frequencies
should be retested.

10. Continue to press STORE after each threshold is found to store that particular threshold.

11. After each threshold is determined and stored, you will notice that as you turn the LEVEL knob to scroll frequencies,
each stored threshold at that particular frequency will be marked by an asterisk (*) and the relevant audiogram symbol
indicating the stored threshold.

12. If you are not performing the test online with the OTOsuite Audiometry Module, plot the results in an audiogram
sheet.

13. Repeat this procedure for the other ear.

Note • If there are differences between the thresholds in the two ears, see Testing with masking► 62.

6.1.2 Sound Field testing
When you select SF transducer, and Free Field speakers (F.F.) are assigned as transducers (SETUP, SETUP items► 87), the
results are stored as an individual threshold curve using the applicable Sound Field symbols (Display► 13).

The symbol used for Sound Field applies to both ears, unless masking has been used.

Tip:
If ear-specific data is retrieved by blocking the contra-lateral ear, activate the masking on the audiometer to use the cor-
rect symbols. This is especially important when you use MADSEN Itera II with the OTOsuite Audiometry Module.

Set the masking level to e.g. -10 dB, and note in the Comments field that the contra-lateral ear was blocked.

6.2 Bone Conduction threshold test

Note • In Bone Conduction testing, masking is always necessary in order to determine in which ear the presented
tone signal is actually heard. This is because of the reduced level of inter-aural attenuation.

Note •Make sure that there are no interfering ambient sounds, particularly at low frequencies. If necessary,
place the patient in a sound booth.

Prerequisites
• Press TONE.

• Press BC.

• If needed, select WARBLE or PULSE as stimulus type.
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• Press the REVERSE button to set the stimulus signal to continuous presentation (use full for placing the bone con-
ductor correctly on the patient).

• Set the dB level to a level that will be heard clearly by the patient.

• Place the bone conductor on the patient. See Preparing for bone conduction testing► 53.

• Find the best position for the bone conductor. Ask the patient to report when the tone seems the loudest.

• Make sure that the bone conductor stays securely in place with no contact to the pinna.

• Give the Patient Responder to the patient and explain how it should be operated (see The patient responder► 52).

• Press REVERSE to deactivate the REVERSE function.

• If you want to use a predefined duration of the signal presentation when you press the INT button, press IMPULSE.

• If you wish to use masking, see Testing with masking► 62.

• If needed, turn the FREQUENCY knob to set the starting frequency: Typical starting frequency: 1000 Hz.

The signal is usually presented for each tone in the following order:

1000 Hz and increasing frequencies,
followed by
frequencies below 1000 Hz in descending order.

The typical test frequencies are:

250 Hz to 4000 Hz.

• Set the initial level of the presented signal to an audible level: Turn the LEVEL knob to 40 dB HL.

This is to familiarize the patient with the test signal. Other familiarization procedures may be preferred.

• If you intend to test both ears, test the better ear first. If this is unknown, start with the right ear. Press L<-->R to
select the ear you wish to test.

6.2.1 Testing
1. Press the INT button (right or left) to present the tone to the patient for 1 to 1.5 seconds.

2. If the patient does not respond to the presented signal, turn the LEVEL knob to increase the signal level in steps of
10 dB until the patient responds.

3. Reduce the signal level by 20 dB until the patient does not respond to the signal.

4. Increase the signal level in steps of 5 dB and present the signal to the patient at each level until the patient responds
to the signal.

5. Reduce the signal level by 10 dB and present signals at levels increased by 5 dB until the patient responds.

6. Repeat item 5, 1 to 3 times until the patient has responded 3 times at the same level.

This level represents the unmasked hearing threshold at 1000 Hz based on 3-5 ascending series.

In some situations, it may be satisfactory with two responses at the same level.

If the patient has responded less than 3 times at the same level after 5 series, present a signal at 10 dB above the level
where a response was last registered.

Then repeat items 3 to 6.

7. When the threshold is determined, press STORE to store that particular threshold. See Store/toggle threshold status
► 23.

8. Turn the FREQUENCY knob to select the next frequency.
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You can link the Store and Next Frequency functions, so that the test progresses with the next frequency when you
press STORE. See SETUP items► 87.

9. Continue to use the right and/or left LEVEL knob to increase/decrease intensities until you have determined all
thresholds.

10. Continue to press STORE after each threshold is found to store that particular threshold.

11. After each threshold is determined and stored, you will notice that as you turn the LEVEL knob to scroll frequencies,
each stored threshold at that particular frequency will be marked by an asterisk (*) and the relevant audiogram symbol
indicating the stored threshold.

12. Repeat this procedure for the other ear.

Note • If the difference between the air conducted threshold and the unmasked bone conduction threshold of
the same ear is 15 dB or greater, it is recommended that you retest bone conduction thresholds with mask-
ing applied to the contralateral ear. See Testing with masking► 62.

6.3 Testing with masking
To prepare the patient for masking, see Preparing for testing with masking► 54.

6.3.1 When is masking required?
When to use masking for Air Conduction testing
If the difference between the thresholds in the two ears is 40 dB (TDH39), or 60 dB (EAR-3A), or greater, it is recom-
mended that you test the poorer ear again with masking applied to the better ear.

If the appliance of masking is to be optimally administered without using unnecessary masking, it is recommended in the
literature not to use the one-number-fits-all 40 dB criterion for circum-aural and 55 to 60 dB criterion for insert phones.
This may cause errors, and will increase the test time, as well as increase the strain on the patient. Instead, the literature
recommends the use of frequency specific criteria that would be taken from transducer specific inter-aural attenuation
tables available from clinical studies.1 See also

When to use masking for Bone Conduction testing
If the difference between the air conducted threshold and the unmasked bone conduction threshold of the same ear is
15 dB or greater, it is recommended that you retest bone conduction thresholds with masking applied to the contralateral
ear. See Testing with masking► 62.

When to use an insert phone
Masking via insert phone is recommended. The insert phone gives less inter-aural cross talk than the TDH39 headphones.

• Use the insert phone instead of the TDH39 headphones for masking when you test the Bone Conduction threshold of
patients with much more hearing loss in one ear than in the other. This will reduce the risk of over-masking caused by
the high masking level required in the poorer ear.

1(Katz, J., Lezynski, J. (2002). Clinical Masking. In J. Katz, ed., Handbook of Clinical Audiology, Williams and Wilkins, Bal-
timore.)
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In order to use the insert phone for masking bone conduction, the EAR-3A must be included as a transducer for your
audiometer. It will be available either as the standard AC transducer, or as an SF transducer. Make sure that it is selec-
ted in SETUP, SETUP items► 87.

The test procedure is similar to that described in Bone conduction with masking - suggested procedure► 64.

Min IA is frequency specific
These are the Min IA tables for TDH-39 and EAR-3A that you can use to optimize the use of masking.

The numbers are rounded down to the closest 5 dB step.

Min IA TDH-39

Hz dB Source

125 35 Katz & Lezynski, (2002)

250 48 Munro & Agnew, BJA (1999)

500 44 Munro & Agnew, BJA (1999)

750 40 N/A - fulfill traditional approach

1000 48 Munro & Agnew, BJA (1999)

1500 40 N/A - fulfill traditional approach

2000 44 Munro & Agnew, BJA (1999)

3000 56 Munro & Agnew, BJA (1999)

4000 50 Munro & Agnew, BJA (1999)

6000 44 Munro & Agnew, BJA (1999)

8000 42 Munro & Agnew, BJA (1999)

Min IA EAR-3A

Hz dB Source

125 35 N/A - traditional approach

250 48 Munro & Agnew, BJA (1999)

500 44 Munro & Agnew, BJA (1999)

750 40 N/A - traditional approach

1000 48 Munro & Agnew, BJA (1999)

1500 40 N/A - traditional approach

2000 44 Munro & Agnew, BJA (1999)

3000 56 Munro & Agnew, BJA (1999)

4000 50 Munro & Agnew, BJA (1999)
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Hz dB Source

6000 44 Munro & Agnew, BJA (1999)

8000 42 Munro & Agnew, BJA (1999)

6.3.2 Air conduction with masking - suggested procedure
Prerequisites
The unmasked hearing thresholds have first been determined as described in Air Conduction threshold test► 59.

Prerequisites as in Air Conduction threshold test► 59.

• Prepare the patient for testing with masking. See Preparing for testing with masking► 54.

• It is recommended to use the default setup used in connection with selectingMASK ON for presenting the masking
signal as continuous presentation.

This means that you will not be using the INT button to control the masking signal.

Testing
1. PressMASK ON to activate contralateral masking.

2. Set the masking level at the threshold of the masking ear and make sure that it is heard by the patient.

If it is not, increase the masking level.

3. Present the tone to the test ear at the unmasked threshold level.

If the tone is not heard, increase the level in 5 dB steps until the patient responds.

4. When the patient responds, increase the masking level in 5 dB steps.

After each increase, present the tone no more than twice. The tone is considered heard if the patient responds at
least once.

If the tone is heard when the masking level has been increased with at least three 5 dB steps, the so called masking
plateau has been reached and the test tone level is considered the masked hearing threshold level.

5. If the tone is not heard when the masking level is increased, increase the test tone level until the tone is heard by the
patient.

Repeat from step 4.

6. If the test tone level at the masking plateau (established in step 4) is within 5 dB from the unmasked threshold level,
you can skip step 7.

7. Keep the established masking level and confirm the masked hearing threshold level. To do so:

Decrease the test tone level by 10 dB and increase in 5 dB steps.

The patient should respond within 5 dB from the previously determined masked threshold level.

If not, repeat from step 2.

8. If required, test the remaining frequencies in the same way and switch to the other ear.

6.3.3 Bone conduction with masking - suggested procedure
Prerequisites
Prerequisites as in Bone Conduction threshold test► 60.

• Prepare the patient for testing with masking. See Preparing for testing with masking► 54.
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• It is recommended to use the default setup used in connection with selectingMASK ON for presenting the masking
signal as continuous presentation.

This means that you will not be using the INT button to control the masking signal.

Testing
1. Establish the unmasked bone threshold. If this has been done previously, and a different level is established in this

step, do not overwrite the previously recorded threshold. The conditions may have changed if the masking trans-
ducers were placed following the first test (for example due to the occlusion effect).

2. PressMASK ON to activate masking.

3. Set the masking level at the air conduction threshold of the masking ear and make sure that it is heard by the patient.

If it is not, increase the masking level.

4. Present the tone to the test ear at the previously confirmed unmasked bone conduction threshold level.

If the tone is not heard, increase the level in 5 dB steps until the patient responds.

5. When the patient responds, increase the masking level in 5 dB steps.

After each increase, present the tone no more than twice. The tone is considered heard if the patient responds at
least once.

If the tone is heard when the masking level has been increased with at least three 5 dB steps, the so called masking
plateau has been reached and the test tone level is considered the masked hearing threshold level.

6. If the tone is not heard when the masking level is increased, increase the test tone level until the tone is heard by the
patient.

Repeat from step 5.

7. If the test tone level at the masking plateau (established in step 5) is within 5 dB from the unmasked threshold level,
you can skip step 8.

8. Keep the established masking level and confirm the masked hearing threshold level. To do so:

Decrease the test tone level by 10 dB and increase in 5 dB steps.

The patient should respond within 5 dB from the previously determined masked threshold level.

If not, repeat from 3.

9. If needed, test the remaining frequencies in the same way and switch to the other ear.

6.4 Storing thresholds
To use the store button, see Store/toggle threshold status► 23.

Results can be stored on a PC when MADSEN Itera II is used with the OTOsuite Audiometry module.
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7 Speech testing
1. Prepare the patient for testing as described in Preparing for testing► 51.

2. To select Speech testing press SPEECH.

3. You can now proceed with:

– Monaural Speech testing► 67, or

– Binaural Speech testing► 69

7.1 Monaural Speech testing

1. When you select Speech testing, the display shows the following:

– the VU meter for the test signal in the top line of the display,

– a speech counter to count the number of words heard correctly or incorrectly by the patient,

– indication of any masking signal,

– the intensity for left and right ear, shown in the bottom line.

7.1.1 Selecting input
Selectingmicrophone or CD input
1. Select microphone or CD input by pressing the MIC. or CD button.

MIC. If you pressMIC. , the microphone selection is shown briefly in the display, as follows:

EXTERN MIC., or
INTERN MIC.

The display then shows the selected microphone input for the current ear:

MIC1 (default), or
MIC2

You can set the sensitivity independently for MIC1 and MIC2 (Adjusting input sensitivity► 68), regard-
less of whether both MIC input channels are routed from:

• a single microphone (the internal microphone, an external table-top microphone or an external mon-
itor headset),

or from

• two different external microphones (gooseneck microphones).

If you are using a MADSEN Itera II with two built-in gooseneck microphones, the following selections apply
(gooseneck microphones are external microphones):

MIC1 = left gooseneck microphone
MIC2 = right gooseneck microphone
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Note • If you connect an external microphone, which can be the monitor headset or the goose-
neck microphones, to EXTERN MIC, this automatically disables the internal microphone (INTERN
MIC.). If no external microphone is connected, the corresponding internal microphone will auto-
matically be selected.

CD If you press CD , CD_1 or CD_2 is shown briefly in the display.

The CD_1 input is Channel 1 (left) on the recording.
The CD_2 input is Channel 2 (right) on the recording.

Switching between input signals
You can switch between input channels:

1. Press and holdMIC. or CD , and simultaneously press
L <--> R.

The display will show the input channel you have selected, and flashes as long as you keep pressing the button.

2. If you wish to switch between all available inputs, turn the frequency selector while you pressMIC. or CD.

This will give you get access to all possible microphone and CD options. If you select CD for one ear and the micro-
phone for the other, bothMIC and CD will light up.

One-channel or two-channel testing
If you wish to operate MADSEN Itera II as a one-channel or a two-channel speech audiometer, select either the same input
to both ears (one-channel) or select two different inputs (two-channel).

When you use two-channel testing, there are 16 possible combinations of inputs.

• Regular one-channel monoaural testing (default)

CD_1 is the default input channel for right or left ears. Masking is available for the opposite ear.

• Two-channel monoaural testing

This test requires special routing. See Special Speech routing► 70.

Adjusting input sensitivity
You can adjust the strength of the input signal:

1. Press and hold the selected input button and use the right LEVEL selector while you check the bar indicator at the
bottom of the display.

2. Make sure that the speech signal is reproduced correctly with the dB value stated in the display: the VU meters must
move into line with "0 dB" on the VU meter scale.

7.1.2 Selecting masking for speech testing
If you select masking, the masking signal is displayed in the first line of the display. You can select

– Speech noise (SPN), or

– White noise (Wide Band Noise - WBN).

1. To adjust the masking signal type selection, select SETUP, SETUP items► 87.
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7.1.3 The counter function in speech testing
There are three ways of counting words in a Speech test. To select the counting method, select SETUP, SETUP items►
87.

Use the right LEVEL selector to select the counting method.

1. OK Words (5-25)
Press PASS to count words heard.

2. FAIL WORDS (5-25)
Press FAIL to count unheard words.

3. OK & FAIL WORDS
You can press both PASS and FAIL to count heard and unheard words with the advantage that you do not need to
listen to the whole list of words, nor state the number of words in the list.

Selecting number of words in list
• Use the FREQUENCY selector to select the number of words (5 - 25) in the list.

Resetting the counter value
• If you change the dB level, the counter value will be reset for starting a new test.

Important•Be careful not to change the dB level before you have made a note of the results.

7.1.4 Interrupting the speech signal
• You can interrupt the speech signal by deactivating the REVERSE button.

Note •There are no interrupt buttons in Speech mode, since they are used for counting words.

7.2 Binaural Speech testing
In binaural Speech testing, a stimulus is presented to both ears, either as a
single signal (one-channel), or as two different signals (two-channel).

1. To perform a standard one-channel binaural Speech test, select Speech
test and press twice on L <--> R.

The input signal currently selected in monaural is also set as input on
the opposite side as default.

This means that if the monaural input was the left CD input channel (CD_
1), and binaural is selected by pressing L <--> R, then the left CD input
channel (CD_1) is also assigned to the right ear.

To change the input channels, see Selecting input► 67.
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7.2.1 One-channel or two-channel Speech testing
To select one or two input channels, see Selecting input► 67.

If you wish to operate MADSEN Itera II as a one-channel or a two-channel Speech audiometer, select either the same input
to both ears (one-channel) or select two different inputs (two-channel).

One-channel binaural test-
ing (default)

CD_1 is the default input channel for both ears. If you wish to use CD_2 for one-channel
testing, you must change both input channels.

• The stimulus level is interlocked and cannot be adjusted separately.

• Masking is available on the audiometer.

Two-channel binaural
testing

Select two different input channels, one for each ear.

• The stimulus levels can be adjusted independently.

• Masking is available on the audiometer.

7.2.2 Adjusting input sensitivity
You can adjust the strength of the input signal:

1. Press and hold the selected input button and use the right LEVEL selector to adjust the strength of the input signal in
the channel which is flashing on the display.

2. Press L <--> R to toggle to the opposite input channel to be able to adjust its sensitivity. To calibrate the speech sig-
nal, the VU meters must move into line with "0 dB" on the VU meter scale.

Caution•You should only use speech materials with a stated relationship between the level of the speech signal
and the calibration signal.

Speech materials delivered on CD or other media are normally accompanied by a description of this relationship.
You should follow the instructions supplied with the speech materials, using the VU-meter in OTOsuite for
adjustment of input gain.

If you are using built-in speech materials supplied with OTOsuite, the speech levels have been adjusted accord-
ing to the original speech material instructions.

7.3 Special Speech routing

7.3.1 Mixing input signals for two-channel monaural Speech

Note • If masking noise is switched on, the input signals cannot be mixed (see Binaural Speech with masking►
71).

• If you press and hold CD orMIC and then press L <--> R, the selected
test input source is sent to the left ear, indicated by an arrow from right
to left.
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• Press once more to send the input to the right ear.

• Press once more to send the input to each ear in the normal way. The
arrow disappears.

7.3.2 Speech in Noise
Adjusting the masking dB level

1. To adjust the masking dB level, use the LEVEL knob on the masking side
to select.

Switchingmasking noise to other ear
1. To toggle the masking noise to the other ear press L <--> R. This lets you switch the masking noise to the same side as

the speech signal.

An arrow appears, pointing to the ear to which the masking is to be presented.

Masking noise in both ears

Note •Binaural masking is not possible in BC testing.

1. To transmit the masking signal to both ears, press and holdMASK ON and then press twice on L <--> R. To disable this
setting, press twice on L <--> R.

When the masking signal returns to normal (contralateral) masking (i.e. when you pressMASK OFF or press L <--> R),
the arrow(s) disappears.

7.3.3 Binaural Speech with masking
1. To switch on masking noise, pressMASK ON. MASK LOCK cannot be

selected.

2. By default, masking noise is transmitted to both ears, but you can select
the masking ear: press and holdMASK ON and press L <--> Ronce to
send the masking noise to the left ear only.

– Press L <--> Ronce more to send the masking noise to the right ear
only. This is how you switch between left and right ear.

– Press twice on L <--> R to send the masking noise to both ears.

7.3.4 Masking level for binaural Speech
1. Turn the FREQUENCY knob to set the masking dB level.
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For a description of how to test a patient and record an audiogram, see Tone testing► 59.
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8 Special tests
1. Prepare the patient for testing as described in Preparing for testing► 51.

2. Press SPECIAL. The available special tests are shown in groups of three on the display. If the MADSEN Itera II is con-
figured with more than three special tests, press SPECIAL until you see the test you wish to use. If SPECIAL flashes,
more tests are available.

3. Press the function key below the test you wish to perform.

The three tests last used will always be displayed first when you press SPECIAL.

8.1 MCL tone testing
1. To test for MCL (Most Comfortable Level) using tones, press SPECIAL one or more times, and press the appropriate

function key to select.

No masking – the stored value symbol isM (No response cannot be stored).

8.2 UCL tone testing
1. To test for UCL (UnComfortable Level) using tones, press SPECIAL one or more times, and press the appropriate func-

tion key to select.

No masking – the stored value symbol isU (No response cannot be stored).

8.3 SISI (Short Increment Sensitivity Index)
The SISI Test was developed by Jerger and co-workers (Jerger, Shedd, and Harford, 1959) and was introduced as a pro-
cedure that was reliable and reasonably objective.

The test consists of superimposing brief bursts of 1 dB intensity increments on a sustained tone presented monaurally
through earphones at a sensation level of 20 dB at each tested frequency.

The patient is instructed to report any jumps in loudness detected while listening to the sustained tone for a period of
about two minutes.

Selecting the test

1. Press SPECIAL one or more times until SISI appears and press the appro-
priate function key to select the test.

The top line shows the intensity (dB HL) to which the increments have
been added, the test name, and the current SISI % score.

The bottom line shows the number of dB increments currently trans-
mitted, the test tone frequency and the scale of the SISI dB increments.

2. To set the number of increments for the test, press SETUP once and use
the Right level knob.

3. To start the SISI test press START/STOP.

The test stops automatically when the selected number of steps in
intensity has been reached, and a beep is heard.

Automatic scoring of responses
The percentage of correct responses (% score) is updated automatically.
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Short increment indication
The presence of a short increment in intensity is indicated by the little L or R test ear indicator in the display changing

momentarily to a rectangle, .

Scoring of responses
• The patient must use the patient responder to register each increment that has been heard.

• Manual scoring

If the patient is unable to use the patient responder, but registers an increment heard in another way, you can press
PASS (right INT button) to indicate that the tone was heard.

Pausing the test
• You can pause the SISI test by pressing START/STOP again. During the pause "SISI" will flash in the display. To resume

the test press START/STOP once more.

Stopping the test
• During a pause, you can stop the test completely by pressing ERASE. Select Yes to erase all SISI data and stop the test

completely, or No to retain SISI data and resume the test.

Restarting the test
• If you press ERASE when the test is in progress, select Yes to erase data. The counter is reset to zero and the test will

start again from the beginning.

Changing the dB level
• To change the dB level use the left LEVEL knob.

Changing the dB increments
• To change the dB increments use the Right level knob (0.25 - 5dB).

If you do so while the test is in progress, the counters are reset to zero and the test starts again from the beginning.

Changing number of increments
• To change the preset number of SISI dB increments transmitted during a test (10-50) press SETUP once and use the

Right level knob. Then press SETUP again to implement the new setting. While the SISI test is in progress, it is not
possible to change the frequency or the number of dB increments.

8.3.1 Masking during SISI
Masking
• To perform masking, pressMASK ON or LOCK.

When you hold down the button, the masking intensity (instead of % score) and signal type are displayed.

Intensity
• To change the intensity press and hold the button and turn the Right level knob.

Signal type
• To change the signal type press and hold the button and turn the left LEVEL knob.
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8.3.2 Using STORE in the SISI test

Note •A maximum of four different sets of SISI values can be stored for both left and right ear.

Storing results

1. When the test is completed for a frequency, press STORE to store:

– SISI % score, number of dB increments administered,

– dB increment,

– dB level for test signal and masking signal (if applicable).

– An * symbol appears by the frequency and an x/o symbol for the left
or right side.

2. Test the next frequency.

8.4 ABLB (Alternate Binaural Loudness Balance)
In this test a tone is transmitted at the same frequency to the left and right ear alternately. The patient must decide when
the same volume is achieved in both ears. The patient indicates this by pressing the patient responder.

1. To select the test press SPECIAL once or more until ABLB is shown.

2. Press ABLB once, and the test display is shown.

The top line shows the intensity for Right and Left channel and the test
name.

The frequency of the test tone and the rate of alternation from ear to
ear and back again (the alternating frequency) appear in the bottom line.

Changing alternating frequency
To change the alternating frequency:

1. Press SETUP once and use the Right level knob (0.25 - 2.5 Hz).

2. Press SETUP again to implement the new setting.

3. You can present the signal in two ways:

– present the signal to the patient by pressing the INT button, or

– press the REVERSE button to present the signal continuously. You can then interrupt the test signal by pressing
the INT button.

Signal presentation (normal/REVERSE) follows the normal rules (see Stimulus/speech count buttons► 24).

8.4.1 Using STORE in the ABLB (Fowler) test
Storing equal volume values
Press STORE to store values of "equal volume".

• You can store up to five sets of measurements for each test frequency.

If you try to save more than five sets of measurements for a given frequency, the message "No more STORE" is shown.
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• You can store a maximum of four test frequencies, which you can select.

If you have stored two or more measurements at the same frequency, you can turn the frequency knob to step
through each of these measurements in turn before changing to the next frequency.

Deleting individual measurements
• To delete an individual measurement press ERASE once while the measurement is displayed. Other measurements at

the same frequency and at other frequencies remain unaffected.

If you change the signal type
If you start a test, and data is stored, you cannot just change the signal type. If you do, the system will not save the data.
The message "Not allowed" is displayed and the button(s) that has/have been wrongly set flash in the correct position
(three short flashes).

Masking

Note •The audiometer cannot performmasking during this test.

8.5 STENGER Test
The Stenger test is used to reveal a unilateral non-organic hearing loss in one ear.

1. Before you perform a Stenger test, measure the patient's tone thresholds for the left and right ears.

2. To select the Stenger test press SPECIAL (one or more times) until "STEN" appears.

3. Select the test by pressing STEN once. The following display appears:

A tone is transmitted at the same frequency on the left and right sides simultaneously.

The display shows the signal selected as stimulus. This is either TON, WRB or NBN. To change the stimulus, see
Changing stimulus► 76

4. Press either of the INT buttons to present the tone to the patient.

Changing dB level
1. You can change the dB level setting separately for the right and the left ear: Set the dB level to 10 dB above the

threshold in the better ear, and 10 dB below the threshold in the poorer ear.

2. You can present the signal in two ways:

– present the signal to the patient by pressing the INT button, or

– press the REVERSE button to keep the signal continuous. You can then interrupt the test signal by pressing the
INT button.

Signal presentation (normal/REVERSE) follows the normal rules (see Stimulus/speech count buttons► 24).

Changing stimulus
You can change the stimulus type from pure tone to Warble (WRB) or Narrow Band Noise (NBN). When you deactivate
these stimulus types, the stimuli return to pure tone (TON).
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1. PressWARBLE to activate or deactivate (see Signal column► 18);

2. Activate Narrow Band Noise (to activate pressMASK ON orMASK LOCK, to deactivate pressMASK OFF). See Mask-
ing► 20.)

If you use the MASK LOCK function to select Narrow Band Noise, you lock together the L and R levels.

8.6 Hearing Instrument Simulation (HIS)
You can use this function to demonstrate how a hearing instrument will sound.

Follow the steps described in The HIS procedure► 77.

A brief description
MADSEN Itera II provides an immediate way of demonstrating how helpful amplification can be. For this purpose, the basic
simulation described below is quite sufficient in most cases.

Make yourself familiar with the process before using it on the patient.

The filter characteristics are applied automatically in HIS, depending on the shape of the audiogram. The following is a
description of the HIS approach:

1. High and low frequency filters are applied to match the slope of the audiogram.

2. The steepness of the audiogram slope in dB/octave is calculated, and the HIS is set to about half this approximated
slope (according to half gain rule) using either 6 dB (less steep slope), 12 dB (medium steep slope) or 18 dB (steep
slope).

3. The frequency where the most amplification is wanted (4 kHz is the highest available) is identified, and the cut-off fre-
quency is set accordingly.

4. A gain is set to approximate half the hearing loss at the frequency selected in step 3 (half gain rule again).

5. Apply the simulation, and ask the patient whether it is comfortable or too loud or soft and adjust the reference level
accordingly.

8.6.1 The HIS procedure
Connect accessories
• Connect the various accessories you will be using for the HIS test.

Audiogram
• Use an audiogram stored in MADSEN Itera II.

or

• Enter an audiogram in MADSEN Itera II.

Prepare the patient
• Prepare the patient for the simulation, for instance by fitting headphones on the patient, and explain the process.

Select test

1. Press SPECIAL (twice, if needed) until HIS is shown on the display.

2. Press the relevant function key to select HIS.

3. One of the following messages will appear:
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Sufficient audiograms are available for both ears

Sufficient audiogram is available for one ear only (in this case the Right
ear).

Press Yes to copy the right audiogram to the left ear.

If you select No, in this example the Hearing Instrument Simulation will
be made for the right ear only.

No sufficient audiograms are available. Enter the audiogram(s) manually
or set the HIS filters manually (Manually adjusting the HIS filters► 80).

4. To continue, press either one of the INT buttons.

Adjust input sensitivity
• Adjust the input sensitivity (Adjusting input sensitivity► 70).

Start the Hearing Instrument Simulation
You are now ready to start the simulation.

• The default settings for the simulation are:

Transducer AC
Alternately SF

Input MIC (live speech)
Alternately CD (One-channel or two-channel Speech testing► 70)

HIS reference level 65 dB SPL
The level for normal speech considered for a person with normal hearing is around 65 dB SPL.
Alternately: See Adjust HIS reference level► 78

1. To start the simulation, press START/STOP.

Adjust HIS reference level
Adjust the HIS reference level. The level for normal speech considered for a person with normal hearing is around 65 dB
SPL.

1. Press SETUP once to view the Reference Level, for instance 65 dB.

2. To change this Reference Level for the HIS test, press SETUP once.

3. The lower line of this display will show "Ref. 65 dB SPL", and from here you can change the setting to any level
between 50 and 80 dB. To do so use the right LEVEL selector within three seconds.

This Reference Level is displayed in SPL.

The effect of the HIS filters is to increase the level by their respective amplification factors at low and high fre-
quencies.

When the display shows "L 0 -HIS- 0 R", the zeros indicate that the hearing level corresponds to the Reference Level
over the entire frequency range. To change this, see Adjusting HIS "Master Volume"► 79.
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Muting the simulator
If required, you can temporarily mute the output: Press REVERSE to deactivate the output (the button indicator turns off).

Both OUTPUT indicators light up automatically.

Simulating amplification
The HIS always starts in unsimulated mode. The display shows -HIS- to indicate that the simulation filters are not activated.
This means that the sound is presented without simulated amplification.

• Starting simulation

To start simulating, you must activate the HIS filters by pressing the START/STOP button. To show the benefit of a
hearing instrument, use the START/STOP button to switch between simulating and not simulating the amplification.

• The display shows a + symbol for the ear where a simulation filter is activated.

A. Master volume
B. No filter activated
C. Filter activated

Adjusting HIS "Master Volume"

Note •The system automatically sets the Master Volume.

• Increasing the output level manually

You can manually increase the output level by adding to the Reference Level.

– Use the right and leftLEVEL knobs to change the "Master Volume" as follows:

– The Master Volume for left and right ears are locked together as default. MASK LOCK is lit.

– Use the left or rightLEVEL knob to control the "Master Volume" for both ears together.

– If you wish to control the "Master Volume" for the two ears individually, pressMASK LOCK to deactivate the
locked function.

Example:

Sound level = Ref. level + 10 = 65 + 10 = 75 dB SPL in both ears.
None of the filters is active.

8.6.2 Viewing thresholds and filters
1. You can use the FREQUENCY knob to view stored thresholds and resulting filters graphically.
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Note •The aspect ratio displayed is scaled, based on the audiogram thresholds listed at the beginning of this
example.

TONE denotes AC
BONE denotes BC
HISF denotes Hearing Instrument Simulator Filter.

2. If the simulation is not satisfactory, use the manual procedure described inManually adjusting the HIS filters► 80to
further adjust.

8.6.3 Manually adjusting the HIS filters
The filters are in series, but could theoretically still be set to simulate a three-band hearing instrument by selecting dif-
ferent cut-off frequencies and adjusting the different gains and the reference level.

Note • In the standard automatic HIS setup described in The HIS procedure► 77 this is done automatically.

If you wish to change the HIS filter parameters for the left or right ear, press
either the left or right INT button. The filter characteristics for the selected
ear are shown.

The top line shows

• the selected ear

• whether the currently displayed parameters apply to the filter for – low pass (LP ), or

– high pass (HP ).

The second line shows

• the filter's 3 dB cut-off frequency

• the filter slope (in dB per octave)

• the (asymptotic) amplification at the filter cut-off frequency.

Changing values
The arrow points to a setting which you can change. To change a setting:

• Use the left LEVEL knob to move the arrow to the required setting.

• Use the Right level knob to change the setting.

Moving the arrow also steps between the LP and HP filters.

When you have set up the filter values, press the relevant INT button to return to the normal HIS screen.

You can press the START/STOP here, and the filters are updated online if you change a value while the filter is activated.
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Parameter LP filter frequencies HP filter frequencies

Cut-off frequency 250, 500, 1000, 2000 Hz 1000, 2000, 3000, 4000 Hz

Slope 6, 12, 18 dB/octave 6, 12, 18 dB/octave

Gain above a selectable reference level 0, 5, 10, 15, 20, 25 dB 0, 5, 10, 15, 20, 25 dB

See The HIS procedure► 77, and The HIS procedure► 77 to continue the procedure.

Filter examples
Any filter whose amplification is set to 0 dB has no effect.

Fig. 2 Low pass filter graph

Fig. 2► 81 shows a graph where the characteristics of a low pass (bass) filter are set to an amplification of +20dB for
frequencies under 250 Hz.

Fig. 3 High pass filter graph

Fig. 3► 81 shows a graph where the characteristics of a high pass (treble) filter are set to an amplification of +25dB
for frequencies over 2000 Hz.
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8.7 Overview of monaural/binaural test signals and the masking side
Test signal Masking signal

Monaural Binaural Ipsi Contra

THR X X

SPEECH X X X X

SISI X X

ABLB X

STEN X

HIS X

Fig. 4 Monaural/binaural test signals and masking side
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9 Managing Data and Results

9.1 Transferring test results from the audiometer to the PC
To transfer test results from your audiometer:
• Switch on the audiometer.

• In the OTOsuite Audiometry Module select Tools > Fetch Test Results...

Follow the onscreen instructions.

9.2 Storing data
• You can store one set of AC data and one set of BC data, including thresholds for each frequency.

• You can delete these thresholds one by one or collectively.

• You can transfer these data to a PC with the OTOsuite Audiometry Module.

9.3 Printing results
From the PC you can print audiograms that have been saved in the OTOsuite Audiometry Module.
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9 Managing Data and Results
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10 Setup of parameters

10.1 What does SETUP do?
You can use SETUP to define all of the normal parameters and setups in the audiometer.

Permanent changes
You can change the parameters permanently and save them in a specific test setup of your choice

• How to use SETUP► 85

• SETUP items► 87

Temporary changes
You can make temporary changes to the various parameters during a test. These changes will not be saved.

• Temporary changes in the setup► 86

10.2 How to use SETUP

10.2.1 Permanent changes in the setup
1. To access changing your parameters press twice on SETUP.

When the SETUP function is active, the SETUP indicator light flashes. Most other buttons are deactivated and audi-
ometry cannot be performed.

2. Turn the left LEVEL knob to select the parameter item you wish to change.

When you select a new item, the item number is displayed briefly in the bottom line, for instance:

Item 5

As a rule, the top line in the display contains a description of the current parameter, for instance:

SF TRANSDUCER

The bottom line contains the value that you can change. The values available are shown one line at a time, for
instance:

---- (None)

HDA 200

TDH39

EAR-T.

(E-A-R-TONE® 3A)

F.F.

3. To change the actual parameter value, for most items, use the Right level knob.

4. Changes made under SETUPwill be saved when you leave SETUP, and will apply the next time MADSEN Itera II is
switched on.

5. The most recently selected item will also be the one displayed the next time you activate SETUP.

6. To exit this function press twice on SETUP.

10.2.2 Return to default settings
To return to the default settings, see SETUP items► 87.
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10.2.3 Temporary changes in the setup
ShortCuts
ShortCut is a faster way to access some of the parameters. Changes made to parameters via ShortCut will not be saved
when MADSEN Itera II is switched off.

• Signal column► 18

• Signal column► 18

• Signal column► 18

• Signal column► 18

• Input - MIC, CD, REVERSE► 18

• Talk over► 22

• Talk over► 22

• Talk over► 22

• Talk over► 22

• Talk back► 20

• Masking► 20

• Masking► 20

• Frequency► 25

• Warble modulation► 23

• Signal type, SISI► 23

• Master volume, HIS ► 23

• Stimulus/masking intensity knobs► 23

• Talkback level► 24

• Warble modulation, amplitude► 24

• Pulse frequency► 24

• Impulse time► 24

• Input sensitivity, speech► 24

• Word counting method, speech► 24

• Alternating Fowler frequency► 24

• Master volume, HIS ► 24

• Parameter selection, SETUP► 24

• Power out voltage► 24
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10.3 SETUP items

SETUP items:
1 SAVE TEST SETUP► 88
2 SET DEF. TEST P.► 88
3 AC TRANSDUCER ► 88
4 BC TRANSDUCER ► 88
5 SF TRANSDUCER ► 88
6 ACMASKING► 88
7 BCMASKING► 88
8 SF MASKING► 89
9 MASK. PRESENT.► 89
10 TONE MASK. SIG.► 89

11 SPEECHMASK. SIG.► 89
12 SPEECH COUNT► 89
13 FREQ.CH.AT STORE► 89
14 DB LEV. NEW TRA.► 91
15 DB LEV. NEW FREQ► 9116 MASKING LEVEL► 94
17 PULSE FREQUENCY► 94
18 IMPULSE LENGTH► 94
19 WARBLE MOD. SIZE► 94
20 WARBLE FREQUENCY► 95

21 SELECT AC FREQ.► 95
22 SELECT BC FREQ.► 95
23 SIGNAL UNIT► 95
24 MIC INPUT SENSE► 95
25 CD INPUT SENSE► 95
26 TALK OVER ► 96
27 TALK BACK MIC.► 96
28 MONITOR ON/OFF ► 96
29 MONITOR LEFT► 96
30 MONITOR RIGHT► 96

31 LIGHT INTENSITY► 96
32 INTERNAL BEEP► 96
33 EXT. RANGE► 96
34 EXT.R. dB-SPACE► 97
35 BAUDRATE► 97
36 CD POWER SUPPLY► 97
37 DISPLAY► 97
38 STIMULI KNOB ► 97
39 DEFAULT SETTING► 97
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1 SAVE
TEST SETUP

Saves a test setup, e.g. masking ON, signal type WARBLE and presentation REVERSE, so that this setup is
used the next time the device is switched on. To use this item, press STORE.

Note •When Itera II is switched on and you choose between various tests, Itera II will always
revert to the setup last used for a given test.

2 SET DEF.
TEST P.

Activates the default setting for the relevant test. All settings are set to the "default" values; for the THR
test for example, the setting will be as follows: signal="TONE", mask="OFF", dB="5", etc.

If this setting is to apply next time Itera II is switched on, go to 39 DEFAULT SETTING► 97 afterwards.
To use this item, press STORE.

3 AC
TRANSDUC-
ER

Choose between calibrated headphones:

• ---- (None)

• HDA 200

• TDH 39

• EAR-T. (E-A-R-TONE® 3A)

Note • If the wrong headphone is selected compared to the one that is physically connected to
Itera II, the measurements will be incorrect!

4 BC
TRANSDUC-
ER

Choose between calibrated bone conductors:

• ---- (None)

• B-71M (Mastoid)

• B-71F (Forehead)

5 SF
TRANSDUC-
ER

Choose between calibrated headphones/free-field loudspeakers:

• ---- (None)

• HDA 200

• TDH39

• EAR-T. (E-A-R-TONE® 3A)

• F.F.

6 AC
MASKING

Select masking transducer for AC:

• ---- (None)

• AC TRANSDUCER

• BC TRANSDUCER

• SF TRANSDUCER

7 BC
MASKING

Select masking transducer for BC

---- (None)
AC TRANSDUCER
SF TRANSDUCER
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8 SF
MASKING

Select masking transducer for SF

• ---- (None)

• AC TRANSDUCER

• BC TRANSDUCER

• SF TRANSDUCER

9 MASK.
PRESENT.

Set mode for masking interrupter:

CONTINUOUS • The masking signal is always present

FREE NORMAL • The masking signal follows the right interrupter - present when button
is pressed.

FREE INVERSE • The masking signal follows the right interrupter - disappears when but-
ton is pressed.

LOCKED NORMAL • The masking signal follows the right and left interrupter -present when
button is pressed.

LOCKED INVERSE • The masking signal follows the right and left interrupter - disappears
when button is pressed.

10 TONE
MASK. SIG.

Select masking stimulus for Tone test

• NBN

• WBN

11 SPEECH
MASK. SIG.

Select masking stimulus for Speech test

• SPN

• WBN

12 SPEECH
COUNT

Select number of words in a list, and select counting method. For further details, look under speech audi-
ometry in Speech testing► 67.

• OK & FAIL WORDS

• FAIL WORDS (5-25)

• OK WORDS (5-25)

13
FREQ.CH.A-
T STORE

Method for frequency change when you press STORE.

• NO CHANGE (the frequency remains the same)
If this parameter is set to “No change”, the setting will remain for instance at 40 dB at 1000 Hz when
you press STORE. See the following example.

dB Hz

40 1000 Press STORE...

...continues at 40 1000

• WRAP
If you press STORE at the highest possible frequency, you switch to the lowest possible frequency.
At other frequencies, pressing STORE advances the frequency. See the following example.
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dB Hz

40 1000 Press STORE...

...continues at 40 1500 Press STORE...

...continues at 40 2000 Press STORE...

...continues at 40 3000 Press STORE...

...continues at 40 4000 Press STORE...

...continues at 40 6000 Press STORE...

...continues at 40 8000 Press STORE...

...continues at 40 12500 Press STORE...

...continues at 40 125 Press STORE...

...continues at 40 250 Press STORE...

...continues at 40 500 Press STORE...

...continues at 40 750 Press STORE...

...continues at 40 1000

• BUTTERFLY
If you press the STORE button at the highest or the lowest possible frequency, you change to
1000 Hz.

Itera II will automatically test frequencies above 1000 Hz in ascending order, and frequencies below
1000 Hz in descending order. See the following example.
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dB Hz

40 1000 Press STORE...

...continues at 40 1500 Press STORE...

...continues at 40 2000 Press STORE...

...continues at 40 3000 Press STORE...

...continues at 40 4000 Press STORE...

...continues at 40 6000 Press STORE...

...continues at 40 8000 Press STORE...

...continues at 40 12500 Press STORE...

...continues at 40 1000 Press STORE...

...continues at 40 750 Press STORE...

...continues at 40 500 Press STORE...

...continues at 40 250 Press STORE...

...continues at 40 125 Press STORE...

...continues at 40 1000 Press STORE...

...continues at 40 1500 Press STORE...

14 DB LEV.
NEW TRA.

Choice of initial volume level for a new transducer, or change between different tests.

• NO CHANGE or adjustable in the range: -10 to 50 dB

15 DB LEV.
NEW FREQ

Choice of initial intensity when changing frequency.

• NO CHANGE (the frequency remains the same) or adjustable in the range -10 to 50 dB.
See the example (with setting 13 set toWRAP ):
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dB Hz

40 1000 Press STORE...

...continues at 40 1500 Press STORE...

...continues at 40 2000 Press STORE...

...continues at 40 3000 Press STORE...

...continues at 40 4000 Press STORE...

...continues at 40 6000 Press STORE...

...continues at 40 8000 Press STORE...

...continues at 40 12500 Press STORE...

...continues at 40 125 Press STORE...

...continues at 40 250 Press STORE...

...continues at 40 500 Press STORE...

...continues at 40 750 Press STORE...

...continues at 40 1000

• XX dB FIXED
New fixed value.
See the example (with setting 13 set toWRAP ):
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dB Hz

40 1000 Press STORE...

...continues at -10 1500 Press STORE...

...continues at -10 2000 Press STORE...

...continues at -10 3000 Press STORE...

...continues at -10 4000 Press STORE...

...continues at -10 6000 Press STORE...

...continues at -10 8000 Press STORE...

...continues at -10 12500 Press STORE...

...continues at -10 125 Press STORE...

...continues at -10 250 Press STORE...

...continues at -10 500 Press STORE...

...continues at -10 750 Press STORE...

...continues at -10 1000

• XX dB ABOVE THR
New fixed value above any previously located threshold value.
See the example (with setting 13 set toWRAP )
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dB Hz

40 1000 Press STORE...

...continues at 30 1500 Press STORE...

...continues at 20 2000 Press STORE...

...continues at 10 3000 Press STORE...

...continues at 0 4000 Press STORE...

...continues at -10 6000 Press STORE...

...continues at -10 8000 Press STORE...

...continues at -10 12500 Press STORE...

...continues at -10 125 Press STORE...

...continues at -10 250 Press STORE...

...continues at -10 500 Press STORE...

...continues at -10 750 Press STORE...

...continues at -10 1000

• Withmasking

dB Hz Masking level

40 1000 30 Press STORE...

...continues at 30 1500 20 Press STORE...

...continues at 20 2000 10 Press STORE...

16
MASKING
LEVEL

Choice of whether the level remains at its current value (Manual) or automatically adjusts to the
threshold of the opposite ear (Automatic):

• Manual or Automatic

17 PULSE
FREQUENC-
Y

Choice of pulse frequency:

• 0.25 to 2.50 Hz

18 IMPULSE
LENGTH

Selection of the fixed period of time during which the signal will be presented when IMPULSE mode is
selected.

• 0.25 to 2.50 seconds

19 WARBLE
MOD. SIZE

Set modulation size as a %:

• 1 to 25% e.g.: At 5% the signal modulates 5% in relation to default frequency
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20 WARBLE
FREQUENC-
Y

1 Hz to 20 Hz

21 SELECT
AC FREQ.

Here you can select (ON) or cancel (OFF) the frequencies to be included for automatically changing fre-
quencies when you store AC thresholds.

The frequencies are selected using the FREQUENCY selector.

ON/OFF is selected using the right LEVEL selector.

Note •This setting does not influence the Frequency knob, and accordingly, all frequencies
(including inter-octave frequencies) are available when you use the Frequency knob.

However, if the frequency 125 Hz is not included in the SELECT AC FREQ. setting, then it will not be
included when you use the Frequency knob.

22 SELECT
BC FREQ.

Here you can select (ON) or cancel (OFF) the frequencies to be included for automatically changing fre-
quencies when you store BC thresholds.

The frequencies are selected using the FREQUENCY selector.

ON/OFF is selected using the right LEVEL selector.

Note •This setting does not influence the Frequency knob , and accordingly, all frequencies
(including inter-octave frequencies) are available when you use the Frequency knob.

23 SIGNAL
UNIT

• HL

• SPL LED-FLASH

If SPL is selected, the dB button will flash to indicate that the display is showing SPL values and not
HL values.

24 MIC
INPUT
SENSE

Selection of microphone input sensitivity (MIC LED is lit).

If you press and holdMIC , you can adjust the left microphone with the left LEVEL selector and the right
microphone with the right LEVEL selector.

If you turn the right LEVEL selector without pressingMIC , both right and left microphones are adjusted
and the display shows an average of the two.

25 CD
INPUT
SENSE

Selection of CD/Tape input sensitivity (CD LED is lit).

If you press and hold CD , you can adjust the left input with the left LEVEL selector and the right input
with the right LEVEL selector.

If you turn the right LEVEL selector without pressing CD , both right and left inputs are adjusted and the
display shows an average value.
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26 TALK
OVER

(EXTERN if external microphones connected, otherwise INTERN)

Possible settings:
Frequency selector:

• Switches between dB level fixed (FIX) or dB level relative to any saved threshold value (THR) for fre-
quencies 250, 500, 1000, 2000, 4000 Hz.

L <--> R button:

• Sends the Talk Over signal to the right or left headphone. Press twice to transmit the signal to both
ears.

When you press and hold TALK OVER , the following adjustments can be made:

• Left LEVEL selector: Output level in headphone (dB HL)

• Right LEVEL selector: Microphone sensitivity for Talk Over.

27 TALK
BACK MIC.

Selection of sensitivity for Talk Back microphone.

28
MONITOR
ON/OFF

Switches the monitor ON or OFF.

• Tone/Speech/Masking: Choose the stimulus using the FREQUENCY selector.

• On/Off: Enable/disable monitoring of the chosen stimulus using the right Level selector.

29
MONITOR
LEFT

Selection of volume for left monitor.

30
MONITOR
RIGHT

Selection of volume for right monitor.

31 LIGHT
INTENSITY

Selection of brightness in LEDs (All LEDs are lit).

32
INTERNAL
BEEP

Switches the internal beeper in connection with the patient's response switch, and under item change in
SETUP, ON or OFF.

Fault beeps are not removed

33 EXT.
RANGE

Selection of one of three modes (see description in Extended range► 19):

• Auto

• Manual

• Timeout
Selection of the time interval that passes between the device standing untouched and the EXTended
(sound intensity) RANGE is deactivated.

If OFF is selected, this safety feature is disabled.

Options: OFF, 20 seconds to 120 seconds

Default: Auto.
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34 EXT.R.
dB-SPACE

Selection of the sound intensity range below the maximum value for which selection of EXTended
RANGE is permitted.

• 30 dB to 70 dB below max.

35
BAUDRATE

Selection of baud rate for RS232 interface.

• 9600, 19200 (default value), 38400, 57600.

36 CD
POWER
SUPPLY

Selection of voltage for CD power supply.

• OFF and 1.5 V to 10.0 V set using the right LEVEL selector.

Note •Remember to use an adapter if necessary so that the CD has the correct polar-
ity. The centre pin is + and the sheath is 0 V.

37 DISPLAY Controls display setup. Fixes one of the four left/right configurations:

SIGNAL AS L/R • The signal for the left ear is shown on the left side, and that for the
right ear on the right side. Masking is on the opposite side.

SIGNAL AS R/L • The signal for the left ear is shown on the right side, and that for the
right ear on the left side. Masking is on the opposite side.

FIX SIGNAL ON L • The signal is shown on the left side, and masking on the right side.

FIX SIGNAL ON R • The signal is shown on the right side, and masking on the left side.

38 STIMULI
KNOB

Controls the functions of the left and right LEVEL knobs:

FIX SIG. TO L • The signal is controlled by the left LEVEL knob and masking by the
right LEVEL knob.

FIX SIG TO R • The signal is controlled by the right LEVEL knob and masking by
the left LEVEL knob.

FOLLOW DISPLAY • The stimuli (signal/masking) controlled by the left and right LEVEL
knobs correspond to the placing (left/right) of the stimuli on the
display.

39
DEFAULT
SETTING

Sets all SETUP parameters to default.

• Press STORE.

The default values are:
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3: AC TRANSDUCER None

4: BC TRANSDUCER None

5: SF TRANSDUCER None

6: AC MASKING None

7: BC MASKING None

8: SF MASKING None

9: MASK.PRESENT. Continuous

10: TONMASK. SIG. NBN

11: SPEECH MASK. SIG. SPN

12: SPEECH COUNT FAIL WORDS 20

13: FREQ.CH.AT STORE WARP

14: DB LEV. NEW TRA. 20 dB

15: DB LEV. NEW FREQ No change

16: MASKING LEVEL Manual

17: PULSE FREQUENCY 1.50 Hz

18: IMPULSE LENGTH 1.50 seconds

19: WARBLE MOD.SIZE 5%

20: WARBLE FREQUENCY 5Hz

21: SELECT MANU.FREQ All frequencies on

22: SELECT AUTO.FREQ All frequencies on

23: SIGNAL UNIT HL

24-27 Half gain

28: MONITOR ON/OFF Tone On, Speech On, Masking Off

29 - 31 Half gain

32: INTERNAL BEEP ON

33: EXT.R. TIMEOUT Off

34: EXT.R. dB-SPACE 30 dB below max.

35: BAUDRATE 19200 Baud

37: DISPLAY Fix signal on Left

38: STIMULI KNOB Fix signal to Left

98 Otometrics - MADSEN Itera II

10 Setup of parameters



11 Configuring the Audiometry Module
You must run the ConfigurationWizard before you can use the Audiometry Module and the audiometer for the first time.
You can also use the wizard later to change specific settings or, for example, to repair the connection between the Audi-
ometry Module and the audiometer.

1. Select Tools > ConfigurationWizard...

2. Click on Configure... next to Audiometry.

3. Enter your selections and click on Next to continue the configuration or Finish to return to the Applications page of
the configuration wizard.

Audiometers

Connect to the device you
wish to use for testing.

• Click on the device you wish to use.

– If the device is not listed, check the check boxMy device is turned on and
ready to be found, and click on Search.

Test Type

Show "test type" • Click to enable viewing any of these test types as a test tab selection on the Audi-
ometry test screens.

If a User Test is set up to include either of these tests, and they have been dis-
abled in this screen, you will be prompted to enable them here.

Masking Assistant

Masking Criteria Define the masking criteria for insert phone(s), earphones, and high frequency
earphones (if applicable).

Air-Bone Gap Criterion Set the dB level for the Air-Bone gap criterion.
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12 Communicating with the device
Connecting to the device
OTOsuite is designed to communicate with and display test data generated by Otometrics test devices.

• When you start up OTOsuite, click on the Control Panel icon. OTOsuite will automatically connect to the test device.

• See also the section "Activating the Control Panel" in the OTOsuite User Guide.

Firmware update
If a Firmware Update message appears, see:

• Updating device firmware► 100

Information about the test device
To see information relating to the test device, select Help > About Device.

12.1 Reconnecting to the device
If the control panel for a test type is shown, and communication with the selected test device is interrupted, a message
appears stating that there is no longer connection to the device.

• Click the Connect button on the Control Panel to reconnect to the selected test device.

Information about the test device
To see information relating to the test device, select Help > About Device.

12.2 Updating device firmware
If the OTOsuite software version contains a more recent firmware for the device, a message will appear when next you
switch on the device.

It is recommended that you update the device firmware to make sure that the device and OTOsuite perform correctly.

• Follow the on-screen instructions.
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13 Maintenance and calibration
MADSEN Itera II requires no preventive maintenance except for regular calibration of the transducers.

See Calibration► 102.

13.1 Service and repair
It is recommended that you keep the packing material in which MADSEN Itera II was delivered. If you need to send it in
for service, the original packing material will ensure protection against damage during transport, etc.

Warning•For the sake of safety and in order not to void the warranty, service and repair of electro-medical
equipment should be carried out only by the equipment manufacturer or by service personnel at authorized work-
shops. In case of any defects, make a detailed description of the defect(s) and contact your supplier. Do not use a
defective device.

Note •There are no user-serviceable parts inside the MADSEN Itera II cabinet.

On request, your supplier can obtain a service manual from the factory. The service manual contains electrical diagrams,
descriptions, lists of components and calibration instructions, etc.

13.1.1 Fuses
To replace or inspect a fuse, proceed as explained below.

Warning•Risk of fire. Before replacing a fuse, first switch off the instrument and disconnect it from
the mains power supply.

The fuse-holders are located next to the AC power connector (or they are integrated with the power connector).

To remove a fuse:

• Unscrew the end of the fuse-holder using a screwdriver with a blade at least 6 mm wide (or remove the power con-
nector).

Fuse types
The fuse is a push-fit in the end of the fuse-holder. When you replace fuses, use only fuses of type T 1 A H/250 V, 5 mm x
20 mm.

13.2 Cleaning

Cleaning the device
There are no specific requirements to sterilization or disinfection of the test device.

Make sure that the instrument is kept clean and free of dust:

• Remove dust using a soft brush.

• To clean the cabinet, use a soft, slightly damp cloth with a small amount of mild detergent on it.
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Caution•Do not allow any moisture inside the instrument!

• To clean the display, use a dry cloth or soft brush. Note that the display is laminated for maximum readability and must
therefore be treated with care.

Headphones
The headphones are in constant contact with the patient, and should therefore be kept clean.

Clean the headphones between patients, e.g. with a non-alcohol based antibacterial wipe, such as Audiowipes.

Eartips for Insert Earphones

Warning•To prevent cross-infection, use new eartips when you test the next client.

The eartips are disposable and therefore should not be cleaned or re-used. There are no special requirements for the dis-
posal of the eartips.

Bone oscillator
Clean the bone oscillator between patients, e.g. with a non-alcohol based antibacterial wipe, such as Audiowipes.

13.3 Calibration
You can download new software to MADSEN Itera II, and if this involves no change to the transducers, MADSEN Itera II
does not need recalibration.

Annual calibration
The audiometer, headphones, bone oscillators, and sound field speakers must be calibrated once a year by your authorized
service department.

The audiometer is dispatched from the factory together with a Test Report (Calibration Certificate). The Test Report spe-
cifies the transducers that have been calibrated (i.e., those which have been supplied together with the instrument),
according to which standards, and the equipment used for calibration. Results are listed for each transducer at all standard
frequencies.

In general, the instrument is calibrated in dB HL and dB masking level using the stated reference equivalent thresholds; dB
HL is related to sound pressure levels, dB SPL = dB re 20 µPa, and force levels (dB re 1 µN).

Caution•Note that calibration has been performed only on the transducers supplied! If you wish to use any other
transducer for testing with the device, please contact your local distributor first.
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14 Unpacking and installing
To install and get started with MADSEN Itera II and the OTOsuite Audiometry Module, follow the sequence below:
• Install OTOsuite on the PC before you connect to MADSEN Itera II from the PC.

• Unpack MADSEN Itera II (see Unpacking► 103).

• Install MADSEN Itera II (see Installation► 103

• Run the OTOsuite Configuration Wizard to connect to and set up communication with MADSEN Itera II. (See Con-
figuring the Audiometry Module► 99).

14.1 Unpacking
Unpack the device carefully.
When you unpack the device and accessories, it is a good idea to keep the packing material in which they were delivered.
If you need to send the device in for service, the original packing material will protect against damage during transport,
etc.Visually inspect the equipment for possible damage.
If damage has occurred, do not put the device into operation. Contact your local distributor for assistance.Check with the
packing list to make sure that you have received all necessary parts and accessories. If your package is incomplete, contact
your local distributor.

1. Check the Test Report (Calibration Certificate), make sure that the transducers (headphones, and bone oscillators) are
the correct ones, and that they comply with the ordered calibration standards.

14.2 Installation
This section provides you with instructions on how to assemble and install MADSEN Itera II.

Note • Install OTOsuite on the PC before you connect to MADSEN Itera II from the PC.

• Before you start using MADSEN Itera II, it is recommended that you leave it at room temperature for 30 minutes - par-
ticularly if it has been stored at very cold or warm temperatures, e.g. if it has been in a car.

• Read the user documentation before you connect or use MADSEN Itera IIfor the first time.

Safety aspects
To ensure safe performance, MADSEN Itera II must be correctly installed and the requirements listed in Standards and
safety► 113 andMADSEN Itera II► 117must be complied with.

Cooling requirements
There are no specific cooling requirements.

Caution•Do not place anything on top of MADSEN Itera II.

Caution•Make sure that MADSEN Itera II is placed in a well ventilated location.

• Place MADSEN Itera II in locations away from sources of heat and direct sunlight.

• MADSEN Itera II must not come into contact with liquids.
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Connections
• Connect required accessories such as the headset, the bone conductor, and the Patient Response Switch to their

respective connectors on the back panel according to the instructions in Air conduction► 104, Bone conduction►
105, External microphone► 105 and the locations described in Socket connections - rear panel► 26.

• The headphone (AC transducer) and SP (SF) transducer connectors and the CD/Tape sockets are color coded as
described in Socket connections - rear panel► 26.

Installation sequence
1. Install OTOsuite on your PC.

2. Assemble and set up MADSEN Itera II.

– Powering► 104

– Connecting to a PC► 104

3. Switch on MADSEN Itera II.

4. Run the Configuration Wizard in OTOsuite to connect to and set up communication with MADSEN Itera II. See Con-
figuring the Audiometry Module► 99.

14.2.1 Powering
1. Plug the power cord into the power socket of MADSEN Itera II.

See Socket connections - rear panel► 26.

2. Plug the other end of the power cord directly into an AC mains power outlet with a three-wire
protective ground.

14.2.2 Connecting to a PC
1. You can connect MADSEN Itera II to a PC by using an RS 232 cable.

See RS232 interface sockets► 107.

2. If required, use a USB converter for your RS232 cable. See your accessories list to order.

14.2.3 Air conduction
See Socket connections - rear panel► 26

Headphones
• Connect the right and left cables (red and blue) from the transducers to the right and left AC sockets in the rear panel

of MADSEN Itera II.

Insert phones
• Connect the Insert phones to the right and left AC socket in the rear panel of MADSEN Itera II.
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They must be connected according to calibration.

Alternatively, connect them to the right and left SF socket.

• To verify the calibration, press [AC]/[SF] and the display will show the transducer calibrated for that output.

14.2.4 Bone conduction
See Socket connections - rear panel► 26.

• Connect the bone conduction transducer plug into the BC socket located in the rear panel of MADSEN Itera II.

14.2.5 External microphone
See Socket connections - rear panel► 26.

In speech testing and patient communication there are two possible external microphone solutions:

• Gooseneck, or

• Boom microphone on the monitor headset.

Connect the chosen microphone solution to the “EXTERNAL MIC/MONITOR HEADSET” socket.

Connecting one of these disables the internal talk-over microphone.

Gooseneck

Monitor headset with boommicrophone

14.2.6 Free Field
See Socket connections - rear panel► 26.
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Without Power Amplifier
• Plug the Free Field transducer cables directly into the R-SF and L-SF sockets located in the rear panel of MADSEN Itera

II. The sound is then routed out through sound field speakers.

•

With Power Amplifier
• Plug the Power Amplifier cables into the two center sockets in the rear panel of MADSEN Itera II.

A. Free Field cables B. Power Amplifier cables
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15 Maximum non-destructive voltage

App. 0.1 Input and output sockets
Maximum non-destructive input voltages for input and output sockets relative to earth connection when the instrument is
switched on.

SP left and right socket 10 V AC ±10 V DC

AC left and right socket 10 V AC ±10 V DC

BC socket 10 V AC ±10 V DC

CD/TAPE left and right socket 12 V AC ±12 V DC

Speech Talk Over socket 12 V AC ±12 V DC

Monitor socket 12 V AC ±12 V DC

Patient Mic/Talk Back socket 12 V AC ±12 V DC

Digital Aux (For future use.) 5 V AC ±5 V DC

Patient responder socket 12 V AC ±12 V DC

DC Power out 30 V AC ±30 V DC

AC mains inlet 1500 V AC ±370 V DC

App. 0.2 RS232 interface sockets
pin 1 (nc) 240 V AC ± 240 V DC

pin 2 (RxDout) 15 V AC *± 15 V DC

pin 3 (TxDin) 30 V AC *± 30 V DC

pin 4 (DTR) 30 V AC *± 30 V DC

pin 5 (ISO Gnd.) 30 V AC ± 30 V DC

pin 6 (DSR) 30 V AC *± 30 V DC

pin 7 (RTSin) 30 V AC *± 30 V DC

pin 8 (CTSout) 15 V AC *± 15 V DC

pin 9 (nc) 240 V AC ± 240 V DC

Relative to pin 5 on the RS232 interface socket.
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15 Maximum non-destructive voltage
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16 Maximum output levels

16.1 Tone
Frequency TDH39 Bone conductor

(B-71)
Insert phone

(E-A-RTONE® 3A)
HDA 200 HolmCo

125 80 105 100 85

250 100 45 110 110 100

500 120 65 120 120 115

750 120 65 120 120 120

1000 120 75 120 120 120

1500 120 80 120 120 120

2000 120 80 120 120 120

3000 120 80 120 120 115

4000 120 75 120 120 115

6000 110 50 110 110 110

8000 100 45 100 105 110

9000 n/a 100

10000 n/a 90

11200 n/a 85

12500 75 80

14000 60

16000 50

n/a: data not available

16.2 NBN
Frequency TDH39 Bone conductor

(B-71)
Insert phone

(E-A-RTONE® 3A)
HDA 200 HolmCo

125 65 95 80 50

250 95 n/a 105 90 100

500 115 n/a 110 100 110

750 115 n/a 110 100 115

1000 115 n/a 115 100 115

1500 115 n/a 115 95 115
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Frequency TDH39 Bone conductor
(B-71)

Insert phone
(E-A-RTONE® 3A)

HDA 200 HolmCo

2000 110 n/a 115 95 100

3000 110 n/a 115 95 100

4000 110 n/a 110 95 100

6000 110 n/a 100 95 100

8000 105 n/a 100 95 105

9000 n/a 90

10000 n/a 85

11200 n/a 85

12500 70 70

14000 60

16000 40

n/a: data not available

110 Otometrics - MADSEN Itera II

16 Maximum output levels



17 Abbreviations
ABLB alternate binaural loudness balance

AC air conduction

AM amplitude modulation

AUTO automatic

BC bone conduction

CD CD (compact disc) player

CH change

DC direct current

DEF default

EXT external

EXT. R. extended range

EXTERN external

FIX fixed talk over level

FM frequency modulation

FREQ frequency

HIS Hearing Instrument Simulation

HISF Hearing Instrument Simulation Filter

HL hearing level

HP high pass

INT internal

INT interrupter

L left

LCD liquid crystal display

LED light emitting diode

LEV level

LP low pass

MANU manual

MASK masking

MCL Most Comfortable Level

MIC microphone

MICL left external microphone

MICR right external microphone

MILI left internal microphone

MIRI right internal microphone

MOD modulation

NBN narrow band noise

o right ear
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P parameters

PC personal computer

PCT percent

R right

SF sound field

SIG signal

SISI short increment sensitivity index

SP special output (same as SF)

SPL sound pressure level

SPN speech noise

STEN Stenger

THR threshold

TON tone

TRA transducer

TRANSD transducer

UCL UnComfortable Level

VU volume unit

WARB warble

WBN wide band noise (white noise)

WRB warble

x left ear
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18 Standards and safety
This manual contains information and warnings, which must be followed to ensure the safe performance of the devices and
software covered by this manual. Local government rules and regulations, if applicable, should also be followed at all times.

See Symbols used► 113 andWarning notes► 114.

18.1 Symbols used
Electronic equipment covered by the Directive 2002/96/EC on waste electrical and electronic equip-
ment (WEEE).

All electrical and electronic products, batteries, and accumulators must be taken to separate collection
at the end of their working life. This requirement applies in the European Union. Do not dispose of these
products as unsorted municipal waste.

You can return your device and accessories to Otometrics, or to any Otometrics supplier. You can also
contact your local authorities for advice on disposal.

Consult user manual for warnings and cautions.

Consult user manual for warnings and cautions.

Consult instructions for use.

Complies with Type B requirements of IEC60601-1.

Complies with Medical Devices Directive 93/42/EEC and RoHS Directive (2011/65/EC).

MEDICAL - General Medical Equipment as to electrical shock, fire and mechanical hazards only in accord-
ance with ANSI/AAMI ES60601-1 (2005) + AMD 1 (2012), IEC 60601-1-6, CAN/CSA-C22.2 No. 60601-1
(2014) and CAN/CSA-C22.2 No. 60601-1-6 (2011).

Suitable for alternating current only.

Power ON.

Power OFF.

Do not reuse.
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18.2 Warning notes
1. This class of equipment is allowed in domestic establishments when used under the jurisdiction of a health care pro-

fessional.

2. Do not use the instrument in the presence of flammable agents (gases) or in an oxygen-rich environment.

3. No parts may be eaten, burnt, or in any way used for purposes other than the applications defined in the Intended Use
section of this manual.

4. The device and any device to be connected which has its own power supply should be turned off before any con-
nections are established.

5. For safety reasons and due to effects on EMC, accessories connected to the equipment's outlet fittings must be
identical to the type supplied with the system.

6. It is recommended that an annual calibration be performed on accessories containing transducers. Furthermore, it is
recommended that calibration be performed if the equipment has suffered any potential damage (e.g. headphones
dropped on the floor).

Note that calibration has been performed only on the transducers supplied! If you wish to use any other transducer for
testing with the device, please contact your local distributor first.

7. Unwanted noise may occur if the device is exposed to a strong radio field. Such noise may interfere with the per-
formance of the device. Many types of electrical devices, e.g. mobile telephones, may generate radio fields. We
recommend that the use of such devices in the vicinity of MADSEN Itera II be restricted.

8. The bone conductor cable and insert phone cable must not be removed or tampered with while
MADSEN Itera II is powered on. Either disconnect the bone conductor or insert phone entirely
from the instrument, or make sure that the instrument itself is disconnected from the power
source.

9. When assembling an electro-medical system, the person carrying out the assembly must take into
account that other connected equipment which does not comply with the same safety require-
ments as this product may lead to a reduction in the overall safety level of the system.

10. When selecting accessories connected to the RS232 socket and DC output of the device, the fol-
lowing points must be considered:

– Use of connected equipment in a patient environment

– Proof that connected equipment has been tested in accordance with Medical Electrical Sys-
tems in IEC 60601-1 3.1 edition: 2012, ANSI/AAMI ES60601-1 (2005) + AMD 1 (2012) and
CAN/CSA-C22.2 No. 60601-1 (2014).

– Do not touch the connectors of the device or connected devices and the patient at the same
time.

11. Grounding continuity should be checked periodically.

12. Avoid using extension cables. The increased length of the cable may increase the resistance of the protective earth
conductor beyond an acceptable level.

13. Operating at the wrong voltage may blow the fuses.For continued protection against fire hazard, replace fuses with the
same type and rating only.

14. To comply with Medical Electrical Systems in IEC 60601-1 3.1 edition:2012, computer and printer must be placed out
of reach of the client, i.e. not closer than approx. 1.5 meters/5 ft.
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15. If the patient microphone is located within the patient area, the microphone should be classified as type B.

18.3 The OTOsuite Audiometry Module
Complies with Medical Devices Directive 93/42/EEC and RoHS Directive (2011/65/EC).

Used in error message dialogs if software program fails. See the detailed information in the dialog box.

18.4 Manufacturer
GN Otometrics A/S
Hoerskaetten 9, 2630 Taastrup
Denmark
( +45 45 75 55 55
7 +45 45 75 55 59
www.otometrics.com

18.4.1 Responsibility of the manufacturer
The manufacturer is to be considered responsible for effects on safety, reliability, and performance of the equipment only
if:

• All assembly operations, extensions, re-adjustments, modifications or repairs are carried out by the equipment man-
ufacturer or personnel authorized by the manufacturer.

• The electrical installation to which the equipment is connected complies with EN/IEC requirements.

• The equipment is used in accordance with the instructions for use.

The manufacturer reserves the right to disclaim all responsibility for the operating safety, reliability and performance of
equipment serviced or repaired by other parties.
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19 Technical specifications

19.1 MADSEN Itera II

Type identification
MADSEN Itera II is type 1004 from GN Otometrics A/S.

Channels

2 separate and identical channels

Pure tone frequencies

AC and SF: 12 standard 125 - 8000 and 12500 Hz

BC: 250 - 8000 Hz standard frequencies

Insert phones 125 - 6000 Hz standard frequencies

Accuracy: Better than 1 %.

Modulation

FM (Warble): 1 - 20 Hz in 1 Hz steps. Mod. width 1% - 25% in 1% steps

AM for SISI: 5, 4, 3, 1, 0.75, 0.50, 0.25 dB HL steps

Wave form: Triangular

Attenuator

1 dB HL / 2.5 dB HL / 5 dB HL step resolution over the entire range

Attenuator accuracy

In whole range: better than 3 dB HL

Between two consecutive attenuator positions:

5 dB HL step: better than 1 dB HL

2.5 dB HL step: better than 0.75 dB HL

1 dB HL step: better than 0.3 dB HL

HL Range

Maximum output will be limited by the transducer.

AC: -10 to 120 dB HL at mid-frequencies

BC: -10 to 70 dB HL at mid-frequencies

HIS function

Low pass frequencies: 250 Hz, 500 Hz, 1 kHz or 2 kHz
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High pass frequencies: 1 kHz, 2 kHz, 3 kHz or 4 kHz

Amplification options: 0, 5, 10, 15, 20, 25 dB SPL

Max. output: 130 dB SPL (for TDH39)

Max. gain: 50 dB SPL

Masking

Narrow band noise, Speech noise and White noise (Wide band noise)

Narrowband noise

Bandwidth: Approximately 0.44 octaves (verified to be within 1/3 and ½ octaves, as
required by audiometer standards).

Calibration: Effective masking according to IEC and ANSI standards.

Speech noise: Fulfills IEC and ANSI requirements to speech noise.

White noise: Bandwidth

Electrical bandwidth: 100-20000 Hz. Acoustic bandwidth is transducer depend-
ent.

Spectrum

Measured in third-octave bands, the spectrum level increases by 3 dB/octave.

Calibration

Calibrated in dB SPL, according to IEC and ANSI audiometer standards. Altern-
atively, calibration according to local standards may be ordered from the man-
ufacturer.

Total harmonic distortion

Air < 2.5 %

Bone < 5 %

Selectable transducers

AC: TDH39, ME-70, and Otometrics insert phones

BC: BC-1, B-71 (Mastoid / Forehead)

SF: TDH39, ME-70, Otometrics insert phones, Free-Field amplifier/loudspeaker

Transducer options depend on how MADSEN Itera II is calibrated.

Outputs

AC: 2 x mono jack, 1/4 "

BC: 1 x mono jack, 1/4 "

SF: 2 x mono jack, 1/4 "
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External inputs

CD/Tape: 0.2 to 2.0 Vrms, 10 k 2 x RCA phone

Microphone: 0.002 to 0.02 Vrms, 2 x 8-pole DIN

Talk Back: 0.002 to 0.02 Vrms, 5-pole DIN for all microphones

DC bias for electric Mic.

Optional input resistance between: 10 k and 600Ω.

Interrupter

Normal: The signal is presented when the INT button is pressed.

Reverse: The signal ceases when the INT button is pressed.

Pulse: The signal is pulsed

The pulse frequency can be adjusted in the range 0.25 to 2.5 Hz in 0.25 Hz
steps.

Impulse: The signal is presented for a preset period of time: 0.25 to 2.5 seconds, in
steps of 0.25 seconds

Operator output

Two stereo monitor sockets (8-pole DIN horseshoe) for headphones. One socket is fitted with a Talk Over Mic. Input
option. The monitor signal follows the test signal, although the volume can be adjusted individually for each channel.

The Talk Back signal from patient to operator is mixed with the monitor signal.

Static force of transducer headbands

TDH 39: 4.5 N ± 0.5 N

B-71: 5.4 N ± 0.5 N

RS232 interface

Format: 8 data bit, 1 stop bit

Parity: Equal

Baud rate: 9600, 19200, 38400, 57600 Baud

Protocol: XON/XOFF

Transport and storage

Temperature: -40°C to + 70°C (-40°F to + 158°F)

Air humidity: 10% to 90%, non-condensing

Air pressure 500 hPa to 1060 hPa
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Operating environment

Mode of operation: Continuous

Temperature: +10°C to +35°C (50°F to +95°F)

Air humidity: 30% to 90%, non-condensing

Air pressure 860 hPa to 1060 hPa.

(Operation in temperatures exceeding -20°C (-4°F) or +60°C (140°F) may cause permanent damage.)

Warm-up time

< 10 min.

Disposal

MADSEN Itera II can be disposed of as normal electronic waste, according to WEEE and local regulations.

Dimensions

Approx. 450 x 290 x 85 mm, 17.7 x 11.4 x 3.3 inches

Weight

Approx. 4.5 kg, 9.9 lb.

Power supply

Internal, 100 - 120 V AC, 200 - 240 V AC, 50/60 Hz

Power consumption

< 60 VA

Fuses

T 1 A H/250 V

Standards

Audiometer: EN60645-1, EN60645-2, EN60645-4, and ANSI S3.6

Patient Safety: Complies with IEC 60601-1 3.1 edition:2012, Class I, Type B; IEC 60601-1-
6:2010; IEC 62366:2007;
CAN/CSA-C22.2 NO 60601-1:2014;
ANSI/AAMI ES60601-1 (2005) + AMD 1 (2012)

EMC: IEC 60601-1-2:2007

Miscellaneous

Internal power supply to CD player: 1.5 - 10 V, 0.5 V steps
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Software-adjustable contrast/brightness on display and LEDs

Integral Talk Over microphone

Digital Aux: 5-pole DIN

19.2 Accessories
Standard accessories and optional accessories may vary from country to country - please consult your local distributor.

• TDH 39 headphones (Headband: HB-7, HB-8)

• ME-70 headphones

• Otometrics insert phones

• Bone oscillators: BC-1, B-71

• Sound field loudspeakers

• Monitor headphones with boom microphone

• Gooseneck talk-over microphones (one right and one left microphone) for speech audiometry and Hearing Instrument
Simulation

• Talkback microphone

• Patient Responder(s)

• Mains cable

• Power supply cable from MADSEN Itera II to CD player

• PA 210 power amplifier for free-field testing

• Wall mount kit for amplifier

• Connection cables

• Audiogram pad

• MADSEN Itera IIReference Manual

• MADSEN Itera II User Guide
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19.3 Notes on EMC (Electromagnetic Compatibility)
• MADSEN Itera II is part of a medical electrical system and is thus subject to special safety precautions. For this reason,

the installation and operating instructions provided in this document should be followed closely.

• Portable and mobile high-frequency communication devices, such as mobile phones, may interfere with the func-
tioning of MADSEN Itera II.

Guidance and manufacturer's declaration - electromagnetic emissions for all equipment and systems

MADSEN Itera II is intended for use in the electromagnetic environment specified below. The user of MADSEN Itera II should ensure that it is used in such an

environment.

Emissions test Compliance Electromagnetic environment - guidance

RF emissions

CISPR 11

Group 1 MADSEN Itera II uses RF energy only for its internal function. There-

fore, its RF emissions are very low and are not likely to cause any

interference in nearby electronic equipment.

RF emissions

CISPR 11

Class A MADSEN Itera II is suitable for use in all establishments other than

domestic and those directly connected to the public low-voltage

power supply network that supplies buildings used for domestic

purposes.

Note: The emissions characteristics of this equipment make it suitable for use in industrial areas and hospitals (CISPR 11 class A). If it is used in a residential envir-

onment (for which CISPR 11 class B is normally required) this equipment might not offer adequate protection to radio-frequency communication services. The

user might need to takemitigation measures, such as relocating or re-orienting the equipment.

Guidance and manufacturer's declaration - electromagnetic immunity for all equipment and systems

MADSEN Itera II is intended for use in the electromagnetic environment specified below. The user of MADSEN Itera II should ensure that it is used in such an envir-

onment.

Immunity test IEC 60601

test level

Compliance level Electromagnetic environment - guidance

Electrostatic dis-
charge (ESD)
IEC 61000-4-2

+/- 6 kV contact

+/- 8 kV air

+/- 6 kV contact

+/- 8 kV air

Floors should bewood, concrete or ceramic tile. If floors are covered with syn-

thetic material, the relative humidity should be at least 30%.

Power frequency

(50/60Hz) magnetic

field

IEC 61000-4-8

3A/m 3A/m Power frequency magnetic fields should be at levels characteristic of a typical loc-

ation in a typical commercial or hospital environment.

UT is the AC mains voltage prior to application of the test level.

Guidance and manufacturer's declaration - electromagnetic immunity - for equipment and systems that areNOT life-supporting

MADSEN Itera II is intended for use in the electromagnetic environment specified below. The user of MADSEN Itera II should ensure that it is used in such an envir-

onment.
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Immunity test IEC 60601

test level

Compliance level Electromagnetic environment - guidance

Radiated RF

IEC 61000-4-3 150 kHz to 80MHzoutside ISM

bands a

3V/m

80MHz to 2.5GHz

3V/m Portable and mobile RF communications equip-

ment should be used no closer to any part of

MADSEN Itera II, including cables, than the recom-

mended separation distance calculated from the

equation applicable to the frequency of the trans-

mitter.

Recommended separation distance:

d = 1.2

d = 1.2 for 80MHz to 800MHz

d = 2.3 for 80MHz to 2.5GHz,

whereP is themaximum output power rating of

the transmitter in watts (W) according to the trans-

mitter manufacturer and d is the recommended

separation distance in metres (m).

Field strengths from fixed RF transmitters, as

determined by an electromagnetic site survey, a

should be less than the compliance level in each

frequency range. b

Interferencemay occur in the vicinity of equip-

ment marked with this symbol:

Note 1: At 80MHz and 800MHz the separation distance for the higher frequency range applies.

Note 2: These guidelinesmay not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and

people.

a. The ISM (industrial, scientific and medical) bands between 150 kHz and 80MHz are 6.765MHz to 6.795MHz; 13.553MHz to 13.567MHz; 26.957MHz to 27.283

MHz; and 40.66MHz to 40,70MHz.

b. The compliance levels in the ISM frequency bands between 150 kHz and 80MHz and in the frequency range 80MHz to 2.5GHz are intended to decrease the

likelihood that mobile/portable communications equipment could cause interference if it is inadvertently brought into patient areas. For this reason, an

additional factor of 10/3 is used in calculating the recommended separation distance for transmitters in these frequency ranges.

c. Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur radio, AMand FMradio

broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an

electromagnetic site survey should be considered. If themeasured field strength in the location in which MADSEN Itera II is used exceeds the applicable RF

compliance level above, theMADSEN Itera II should be observed to verify normal operation. If abnormal performance is observed, additional measures

might be necessary, such as reorienting or relocatingMADSEN Itera II. 

d. Over the frequency range 150 kHz to 80MHz, field strengths should be less than 3V/m.

Recommended separation distances between portable and mobile RF communications equipment and MADSEN Itera II

Rated maximum output
power of transmitter
W

Separation distance according to frequency of transmitter
m

150 kHz to 80MHzoutside ISMbands

d = 1.2

80MHz to 800MHz

d = 1.2

800MHz to 2.5GHz

d = 2.3
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0.01 0.12 0.12 0.23

0.1 0.38 0.38 0.73

1 1.2 1.2 2.3

10 3.8 3.8 7.3

100 12 12 23

For transmitters rated at amaximum output power not listed above, the recommended separation distance d in meters (m) can be estimated using the equa-

tion applicable to the frequency of the transmitter, whereP is themaximum output power rating of the transmitter in watts (W) according to the transmitter

manufacturer.

Note 1: At 80MHz and 800MHz the separation distance for the higher frequency range applies.

Note 2: These guidelinesmay not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and

people.
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Abbreviations 111
ABLB 75
AC connection 26
AC key 17
ACmasking

select transducer 88
AC transducer

select headphones 88
Accessories

AC connection 104
BC connection 105
connections 26
specifications 121

AI 47
Air conduction

testing 59
with masking 62

Air conductor 17
AC connection 26

Alternating frequency
Fowler 24

Amplitude 24
Attenuator

specifications 117
steps 21

Audiogram
combined,

enabling/disabling 31
show combined view, Audiogram

Module 31
show split view, Audiogram

Module 31
viewing frequency range 32
viewing left-right 31
viewing legend box 31
viewing right-left 31
work area in screen 46
work area in screen, Audiogram

Module 39
Audiogram symbols, Audiogram

module 43
Audiogram symbols, Itera II 14

Audiometry
basic functions 29
menu bar 29
OTOsuite toolbar 29
preparing for testing 11
training 11
user interface 29

B
Baud

rate setting 97
BC connection 26
BC key 17
BCmasking

select transducer 88
BC transducer

select bone conductors 88
Beep

function 16
ON/OFF, setting 96

Binaural speech test
input selection 70
input sensitivity 70
masking 71
masking level 71
mixing input signals 70

Bone conduction
BC transducer 88
testing 60

Bone conductor 17
BC connection 26

Butterfly 90

C
Cables

connecting test equipment 52
Calibration 102

certificate 102
CD

power supply voltage,
setting 97

selection 18
CD key 18
CD/tape

connection 27
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select input sensitivity 95
Cleaning 101
Client

inspecting the ear 55
Combined audiogram

enabling/disabling 31
ConfigurationWizard 99
Connections

AC 26
accessories 26
BC 26
CD/Tape 27
DC power OUT 27
external mic./monitor

headset 27
monitor 27
patient response 27
RS232 28
SF 26
SF transducer 26
supply voltage 28
Talk back 27

Control Panel
Audiometry description 35

Controls 15
Counter

start or stop 22
Curves and symbols 41

selecting 32

D
Data

transmission 26
data transmission 26
dB

level for new frequency 91
level for new transducer 91
space setting 97

dB STEP key 21
DC power OUT connection 27
DC POWER OUT voltage 24
Default settings 97
Default test parameters 88
Delete

measuring points 25

thresholds 25
Display 13

setup 97

E
Ear selection 20
ERASE key 25
EXT. RANGE key 19
Extended range

dB-space, setting 97
on or off 19
timeout, setting 96

External mic./monitor headset con-
nection 27

F
Filter

HIS 80
Firmware update, test devices

(Aud.) 100
Fowler 75

alternating tone frequency
setup 20

storing results 75
Frequency

butterfly 90
change test f. 23
change with STORE 89
changing 25
dB level for new f. 91
pulse 94
select automatic 95
select manual 95
specifications 117
warble 95
wrap 89

FREQUENCY key 25
Frequency range, audiogram

viewing 32
Front panel 15

display 13
Functions

AC 17
BC 17
beep 16
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CD 18
dB STEP 21
ERASE 25
EXT. RANGE 19
FREQUENCY 25
IMPULSE 18
input signal 18
INT, left 24
INT, right 25
Level, Intensity 23
LR 20
MASK 20
MASK LOCK 21
MASK OFF 21
MASK ON 21
MIC 18
MIC. 21
PULSE 18
RESPONSE 19, 22
REVERSE 19
SETUP 20
SF 17
SIGNAL 18
SPECIAL 17
SPEECH 17
START/STOP 22
STORE 23
TALK BACK 20
TALK OVER 22
TONE 17
TRANSD. 17
WARBLE 18
XMIT 26

Fuses
fuse types 101
replacement 101

G
Gooseneck microphones

connection 27

H
Headphones

connection 104

Hearing Instrument Simulator
filter 80
master volume regulation 79
reference level 78
specifications 117
value selection 23

HL
range specifications 117
selection 95

Hygienic precautions 55

I
Icons

combined view, Audiogram
Module 31

split view, Audiogram
Module 31

Impulse
length 94
time 24

IMPULSE key 18
Input sensitivity 24

binaural 70
CD/tape 95
microphone 95
monaural 68

Input signals
binaural 70
CD 18
microphone 18
REVERSE 19
selection 18

Insert phones
connection 104

Installation
AC headphones 104
connecting AC accessories 104
connecting BC accessories 105
connections 26
insert phones 104
powering 104

Instrument, overview 13
INT, left key 24
INT, right key 25
Intended use 8
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Interface cable
connection 28

Internal microphone 21
Interrupter

specifications 119
Interrupting speech signal 69

K
Keys 15

AC 17
BC 17
CD 18
dB STEP 21
ERASE 25
EXT. RANGE 19
FREQUENCY 25
IMPULSE 18
input signal 18
INT, left 24
INT, right 25
Level, Intensity 23
LR 20
MASK 20
MASK LOCK 21
MASK OFF 21
MASK ON 21
MIC 18
PULSE 18
RESPONSE 19, 22
REVERSE 19
SETUP 20
SF 17
SIGNAL 18
SPECIAL 17
SPEECH 17
START/STOP 22
STORE 23
TALK BACK 20
TALK OVER 22
TONE 17
TRANSD. 17
WARBLE 18
XMIT 26

L
LEDs

light, setting 96
Left - Right audiogram

viewing 31
Legend

Audiometry 46
Speech Mapping 46

Legend box, audiogram
viewing 31

LR key 20

M
Maintenance 101

replacing fuses 101
Manufacturer 115
MASK key 20
MASK LOCK key 21
MASK OFF key 21
MASK ON key 21
Masking

air conduction 62
binaural 71
level selection 94
level, binaural 71
monaural 68
on/off, lock 20
select AC transducer 88
select BC transducer 88
select presentation 89
select SF transducer 89
select stimulus for speech

test 89
select stimulus for tone test 89
selecting m. transducer 21
signal 25
SISI 74
with monaural/binaural test sig-

nals 82
Masking assistant

enabling/disabling 30
Masking Assistant 33

enabling/disabling 30
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Master volume regulation
HIS 79

MCL, Itera II 73
Measuring points

deleting 25
Menu bar

Audiometry 29
Microphone

internal 21
select input sensitivity 95
selection 18
talk back connection 27

Modulation
specifications 117

Modulation size
warble 94

Monaural speech test 67
input selection 67
input sensitivity 68
masking 68
speech in noise 71
word count 69

Monitor
left, setting 96
ON/OFF setting 96
right, setting 96

Monitor headset
connection 27

monitoring testing connection 27
Most Comfortable Level, Itera II 73

N
Navigating in Audiometry 29
No response 23

O
ON/OFF

power switch 28
Output

maximum levels 109
Overlays

feature box;Feature box
overlays 44

viewing 31
Overview, instrument 13

P
Parameters

ACmasking 88
AC transducer 88
baud rate 97
BCmasking 88
BC transducer 88
CD power supply 97
CD/tape input sensitivity 95
changing 20
dB level new frequency 91
dB level new transducer 91
default settings 97
display setup 97
extended range dB-space 97
extended range timeout 96
frequency change with

STORE 89
impulse length 94
internal beep 96
item selection 23-24
light in LEDs 96
masking level 94
masking presentation 89
microphone input sensitivity 95
monitor left 96
monitor ON/OFF 96
monitor right 96
pulse frequency 94
save test setup 88
select automatic frequency 95
select manual frequency 95
set default test parameters 88
setup 85
SF masking 89
SF transducer 88
shortcut 85
signal unit 95
speech count 89
speech masking signal 89
stimuli knob 97
talk back microphone

sensitivity 96
talk over 96

129 Otometrics - MADSEN Itera II

Index



tone masking signal 89
warble frequency 95
warble modulation size 94

Patient communication
talk over 22

Patient responder connection 27
Patient response

shown on display 19, 22
switch connection 27

PC interface
cable connection 28

Power switch 28
Powering 104
Preparing for testing

Audiometry 11
connecting cables 52
inspecting the client’s ear 55

Pulse frequency 24
PULSE key 18

R
Range, extended 19
Reference level

HIS 78
Replacement

fuses 101
RESPONSE key 19, 22
REVERSE key 19
Right - Left audiogram

viewing 31
RS232 connection 28

S
Safety 113
Save test setup 88
Screens

Speech 45
Tone, Audiogram Module 39

Select orientation
toolbar 32

Sensitivity
talk back microphone 96

Settings
Control Panel 35
default s. 97

Setup
parameters 85

SETUP key 20
SF key 17
SF masking

select transducer 89
SF transducer

select headphones/free-field
loudspeaker 88

SF transducer connection 26
Shortcut

parameters 85
SIGNAL key 18
Signal unit

select 95
SISI 73

changing number of small incre-
ments 20

masking 74
signal type selection 23
storing results 75

Sound field testing 60
SPECIAL key 17
Special tests 73

Fowler (ABLB) 75
SISI 73
Stenger 76

Special transducer 17
Specifications 117

accessories 121
Speech in noise 71
SPEECH key 17
Speech test

heard words 25
masking setup in one ear 20
mixed signals 20
select number of words 89
test signal in both ears 20
the Speech screen 45
unheard words 24

Speech testing 67
interrupting speech signal 69
monaural 67
word count 69
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SPL
selection 95

Standards 113
Start

counter, timer 22
START/STOP key 22
Stenger 76

navigation, speech 46
Stimuli

knob setting 97
Stimulus

impulse 18
pulse 18
selection 18
warble 18

Stimulus/masking intensity 23
Stop

counter, timer 22
STORE key 23
Storing results

Fowler 75
SISI 75

Supply voltage
connection 28

Symbols 113
Symbols and curves

selecting 32
Symbols, audiogram module 43
Symbols, audiogram, in Itera II 14

T
Talk back

level 24
microphone sensitivity 96
volume 20

Talk back connection 27
TALK BACK key 20
Talk over

settings 96
TALK OVER key 22
Technical specifications 117
Test devices

connecting 100
information about 100

Test devices (Audiometry)
firmware update 100

Test equipment
connecting cables,

Audiometry 52
Test frequency

change 23
Test parameters

changing 20
set default 88

Test report 102
Test setup

save 88
Test signals 24

monaural/binaural and
masking 82

Test types 16
Testing 59

ABLB 75
air conduction 59
bone conduction 60
Fowler 75
monaural speech t. 67
SISI 73
special tests 73
speech t. 67
Stenger 76

Tests
controlling from Control

Panel 35
Speech screen 45
Tone screen, Audiogram Mod-

ule 39
Thresholds

deleting 25
store 23

Timer
start or stop 22

TONE key 17
Tone test

the Tone screen, Audiogram
Module 39

Toolbar
Audiometry 29
select orientation 32
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Tools menu
Curves and symbols 32

Tools menu (Aud)
Curves and symbols 32

Training
Audiometry 11

TRANSD. key 17
Transducers

AC 17
AC connection 26
AC, headphones 88
BC 17, 88
calibration 102
dB level for new t. 91
selection 17
SF 17, 88
SF connection 26
specifications 118

Transmission
data 26

U
UCL, Itera II 73
UnComfortable Level, Itera II 73
Unpacking

the test device 103
User interface 29

V
Value selection

HIS 24
View menu

audiogram legend 31
combined audiogram 31
frequency range 32
left-right audiogram 31
Masking Assistant 30
Overlays 31
right-left audiogram 31

View menu (Aud)
audiogram legend 31
combined audiogram 31
frequency range 32
masking assistant 30
Overlays 31

Voltage
maximum non-destructive 107

W
Warble

frequency 95
modulation size 94
selection 23
setup selection 24

WARBLE key 18
Warning notes 114
Word count 24, 69

failed word 24
heard word 25
select method 89

Wrap 89

X
XMIT key 26
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